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• Electrical Safety .................................................................................................................................................................... 12 
• Operational Safety .............................................................................................................................................................. 14 
• Maintenance Safety ........................................................................................................................................................... 16 
• Printer Symbols ..................................................................................................................................................................... 17 
• Environmental, Health, and Safety Contact Information .................................................................................. 18 

Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your Xerox 
printer. 
 

 1 Safety 
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Electrical Safety 

General Guidelines 
 

 WARNINGS: 

• Do not push objects into slots or openings on the printer. Touching a voltage point or shorting 
out a part could result in fire or electric shock. 

• Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are instructed to do so. Turn off the printer when performing these 
installations. Disconnect the power cord when removing covers and guards for installing optional 
equipment. Except for user-installable options, there are no parts that you can maintain or 
service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Turn off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
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Power Cord 
• Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly. 
Electrical products can be hazardous if misused. 

 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• If the power cord becomes frayed or worn, replace it. 
• Do not plug or unplug the power cord while the power switch is in the On position. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 
• Ensure that the electrical outlet is near the printer and is easily accessible. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
 

Emergency Turn Off 

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord 
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
 

Laser Safety 

This printer complies with laser product performance standards set by governmental, national, and 
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous 
light because the beam is totally enclosed during all modes of customer operation and maintenance. 
 

 WARNING: Use of controls, adjustments, or performance of procedures other than those specified in 
this manual can result in hazardous radiation exposure. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Operational Guidelines 
• Do not remove the paper source tray that you selected in either the print driver or control panel 

while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer while is printing. 
• Keep hands, hair, neckties, and so on away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. 

To find the weight for your printer configuration, see Physical Specifications on page 180. 
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer. 
• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at the elevations specified in Elevation on page 184. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=environmenteu&Language=English
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Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumable supplies away from the reach of children. 
• Never throw toner, print/drum cartridges, or toner containers into an open flame. 
• When handling cartridges, for example toner cartridges, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 
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Maintenance Safety 

• Do not attempt any maintenance procedure that is not described in the documentation supplied 
with your printer. 

• Do not use aerosol cleaners. Clean with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. 
• For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa. 
 

 WARNING: Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on 
electromechanical equipment. 

  
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=recyclesupplies&Language=English
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Printer Symbols 

Symbol Description 

 

Warning: 
Indicates a hazard which, if not avoided, could result in death or serious injury. 

 

Caution: 
Indicates a mandatory action to take in order to avoid damage to the property. 

 

Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Do not burn the item. 

 

Do not expose the imaging unit to light for more than 10 minutes. 

 

Do not expose the imaging unit to direct sunlight. 

 

Do not touch the part or area of the printer. 

 

 

Warning: 
Wait for the printer to cool for the specified time before touching the fuser. 

 

This item can be recycled. For details, see Recycling and Disposal on page 201. 
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 

Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=environmenteu&Language=English
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Parts of the Printer 

This section includes: 
• Front View ............................................................................................................................................................................... 20 
• Rear View ................................................................................................................................................................................. 23 
• Internal Components ......................................................................................................................................................... 24 
• Optional 500-Sheet Finisher ............................................................................................................................................ 24 
• Control Panel.......................................................................................................................................................................... 25 
 

Front View 

Standard Configuration 

 
 

1. Tray 1 with 520-sheet capacity 
2. Document Output Tray with 500-Sheet 

Capacity 
3. USB Port 
4. Document Feeder with 100-Sheet Capacity 
5. Document Feeder Top Cover 

6. Control Panel 
7. Side Door 
8. Bypass tray with 100-sheet capacity 
9. Front Door 
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Optional Finisher, Tray 2, and High-Capacity Feeder 

 
 

1. Optional 500-Sheet Finisher 
2. Finisher Front Door 
3. USB Port 
4. Document Feeder with 100-Sheet Capacity 
5. Document Feeder Top Cover 
6. Control Panel 
7. Side Door 
8. Bypass tray with 100-sheet capacity 

9. Front Door 
10. Tray 1 with 520-sheet capacity 
11. Feeder Tray Outside Cover 
12. Feeder Tray Inside Cover 
13. Optional Feeder Tray 2 with 520-Sheet 

Capacity 
14. High-Capacity Feeder Outside Cover 
15. High-Capacity Feeder Inside Cover 
16. Optional 2100-Sheet High-Capacity Feeder 
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Alternate Configuration with Trays 1-4 

 
 

1. Bypass tray with 100-sheet capacity 
2. Tray 1 with 520-sheet capacity 
3. Optional Feeder Tray 2 with 520-Sheet Capacity 

4. Optional 520-Sheet Feeder Tray 3 
5. Optional 520-Sheet Feeder Tray 4 
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Rear View 

 
 

1. Control Board 
2. Control Board Cover 
3. Power Connector 
4. Power Switch 
5. Red LED 
6. Card Reader Slot 
7. Green LED 
8. Finisher Interface 

9. Optional Foreign Device Interface 
10. Ethernet Connection 
11. USB Port for Service Only 
12. Direct Connect Port for USB Printing 
13. Direct Connect Port for USB Printing 
14. Handset Extension Connector for Optional Fax Kit  
15. Fax Line In for Optional Fax Kit 
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Internal Components 

 
1. Toner Cartridge 
2. Drum Cartridge 
3. Smart Kit Drum Cartridge 
4. Document Glass 

5. Document Feeder 
6. Fuser 
7. Transfer Roller 

 
 

Optional 500-Sheet Finisher 

 
 

1. Finisher Connector Cable 
2. Finisher Front Door 
3. Staple Cartridge 
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Control Panel 

The control panel consists of a touch screen and buttons you press to control the functions available on 
the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to print features. 
• Provides access to reference materials. 
• Provides access to Tools and Setup menus. 
• Provides access to Troubleshooting menus and videos. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 
 

 
 

Item Name Description 

1 Touch Screen 
Display The screen displays information and provides access to printer functions. 

2 Services Home 
Button 

This button provides access to printer features such as copy, scan, and fax on the touch 
screen. 

3 Services Button This button returns to the active service from the Job Status or Machine Status screens, 
or to a preset service. 

4 Job Status Button This button displays lists of all active, secure, or completed jobs on the touch screen. 

5 Machine Status 
Button This button displays the status of the printer on the touch screen. 

6 Alphanumeric 
Keypad The keypad enters alphanumeric information. 

7 Dial Pause Button This button inserts a pause in a telephone number when it transmits a fax. 

8 C (clear) Button This button deletes numeric values or the last digit entered using the alphanumeric keys.  

9 Interrupt Button This button pauses the current job to run a more urgent print, copy, or fax job. 

10 Start Button This button starts the selected copy, scan, fax, or Print From job, such as Print from USB. 

11 Stop Button This button stops the current job temporarily. To cancel or resume your job, follow the 
onscreen instructions. 
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Item Name Description 

12 Clear All Button This button clears previous and changed settings for the current selection. To reset all 
features to their default settings and clear existing scans, press this button twice. 

13 Language Button This button changes the touch screen language and keyboard settings. 

14 Power Saver button This button enters and exits the low-power mode. 

15 Help Button This button displays information about the current selection on the touch screen. 

16 Log In/Out Button This button provides access to password-protected features. 
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Information Pages 

Your printer has a printable set of information pages. These include configuration and font information, 
demonstration pages, and more. 
 

Printing the Information Pages 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Self Help. 
3. To print an information page, select an option, then touch Print. 

Note: To scroll through the list of available items, touch and drag your finger up or down on the 
menu. 

4. Touch Close. 
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Power Saver Mode 

Power Saver mode reduces power consumption when the printer is left idle for a specified period of time. 
 

Power Saver Levels 

There are two levels of Power Saver mode. 
• Power Saver Mode 1: After a specified period of inactivity, the touch screen is dims and the printer 

operates on reduced power consumption. 
• Power Saver Mode 2: After a specified period of inactivity, the touch screen turns off and the 

printer enters standby mode. 
 

Exiting Power Saver Mode 

The printer exits Power Saver mode automatically when any of the following events occur. 
• You press a button on the control panel. 
• The printer receives data from a connected device. 
• You open any door or cover on the printer. 
• You load media in the document feeder or bypass tray. 
• You insert a thumb drive or an access card into a port. 
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Administration Features 

This section includes: 
• CentreWare Internet Services......................................................................................................................................... 29 
• Accessing CentreWare Internet Services ................................................................................................................... 29 
• Finding the IP Address of the Printer .......................................................................................................................... 30 
• Automatic Data Collection .............................................................................................................................................. 30 
• Billing and Usage Information ....................................................................................................................................... 30 

For details, see the System Administrator Guide at www.xerox.com/office/WC4265docs. 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in CentreWare Internet Services or the System Administrator Guide. 
 

Accessing CentreWare Internet Services 

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press 
Enter or Return. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
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Finding the IP Address of the Printer 

To install the print drivers for a network-connected printer, you need the IP address of your printer. You 
also need the IP address to access the settings of your printer through CentreWare Internet Services. 

You can view the IP address of your printer on the control panel or on the Configuration Report. 

To view the IP address of the printer on the control panel: 
1. At the printer control panel, press the Machine Status button. 
2. Touch the Machine Information tab. 

− If the system administrator has set the Display Network Settings to show the IP address, it 
appears in the center panel. 

− If the IP address is not displayed, print the Configuration Report or contact your system 
administrator. 

To print a configuration report: 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Self Help > System Configuration > Print. 
3. Touch Close. 

Note: After the printer has been on for two minutes, print the Configuration Report. The TCP/IP 
address appears in the Network section of the page. If the IP address listed on the page is 0.0.0.0, 
the printer needs more time to acquire an IP address from the DHCP server. Wait two minutes, then 
print the Configuration Report again. 

 

Automatic Data Collection 

This printer automatically collects data and transmits it to a secure offsite location. Xerox or a 
designated servicer uses this data to support and service the printer, or for billing, supplies 
replenishment, or product improvement. Automatically transmitted data can include product 
registration, meter read, supply level, printer configuration and settings, software version, and problem 
or fault code data. Xerox cannot read, view, or download the content of your documents residing on or 
passing through your printer or any of your information management systems. 

To turn off automatic data collection: 

On the Welcome page in CentreWare Internet Services, click the link in the note regarding automated 
services. 
 

Billing and Usage Information 

Billing and printer usage information appears on the Billing Meters information screen. The impression 
counts shown are used for billing. For details on viewing this information, see Billing and Usage 
Information on page 141. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/WC4265docs 

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and driver downloads. 

www.xerox.com/office/WC4265support 

Information about menus or error messages Press the control panel Help (?) button. 

Information Pages Print from the control panel, or from CentreWare 
Internet Services, click Status > Information Pages. 

CentreWare Internet Services documentation In CentreWare Internet Services, click Help. 

Order supplies for your printer www.xerox.com/office/WC4265supplies 

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs. 

www.xerox.com/office/businessresourcecenter 

Local sales and support center www.xerox.com/office/worldcontacts 

Printer registration www.xerox.com/office/register 

Xerox® Direct online store www.direct.xerox.com/ 
 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=businessresourcecenter&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=reg&Language=English
http://www.direct.xerox.com/
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This chapter includes: 
• Installation and Setup Overview ................................................................................................................................... 34 
• Selecting a Location for the Printer .............................................................................................................................. 35 
• Configuring the Printer at Setup ................................................................................................................................... 36 
• Connecting the Printer ....................................................................................................................................................... 38 
• Configuring Network Settings ........................................................................................................................................ 41 
• Enabling the Printer for Scanning ................................................................................................................................. 42 
• Installing the Software ...................................................................................................................................................... 43 
• Installing the Printer as a Web Service on Devices ................................................................................................ 47 
 

See also: 
Installation Guide packaged with your printer. 
System Administrator Guide at www.xerox.com/office/WC4265docs. 
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http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
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Installation and Setup Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure 
the initial settings of the printer, then install the driver software and utilities on your computer. 

You can connect to your printer directly from your computer using USB, or connect over a network using 
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables 
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet 
connection because it is typically faster than a USB connection, and it provides access to CentreWare 
Internet Services. 
 

Note: If the Software and Documentation disc is not available, you can download the latest drivers 
from www.xerox.com/office/WC4265drivers. 

  

See also: 
Selecting a Location for the Printer on page 35 
Choosing a Connection Method on page 38 
Connecting the Printer on page 38 
Configuring Network Settings on page 41 
Installing the Software on page 43 
 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=driver&Language=English
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Selecting a Location for the Printer 

• Select a dust-free area with temperatures from 10–30°C (50–90°F), and relative humidity 20–80%. 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

• Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the 
printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the 
weight for your printer configuration, see Physical Specifications on page 180. 

• Select a location with adequate clearance to access supplies and to provide proper ventilation. To 
find the clearance requirements for your printer, see Clearance Requirements on page 180. 

• After positioning the printer, you are ready to connect it to the power source and computer or 
network. 
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Configuring the Printer at Setup 

Once the printer is assembled, to complete the configuration process, use the Product Enablement Key. 
The Product Enablement Key sets the billing mode. 

Note: The Product Enablement Key is packaged in a plastic tube contained inside the box with the 
printer. 

To configure the printer using the Product Enablement Key: 
1. Remove the plastic card that contains the Product Enablement Key from the tube. 

 
2. To remove the Product Enablement Key from the plastic card, carefully press it out. 

 
3. Attach the power cord to the printer, plug the cord into an electrical outlet, then turn on the printer. 

The Installation wizard starts on the control panel the first time that you turn on the printer. 
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4. In the Installation Wizard, to begin, select your chosen language and keyboard layout, then touch 
Next. 

5. On the Product Enablement Settings screen, follow the directions. 
6. At step 2 of the Installation Wizard, insert the Product Enablement Key into the card reader slot at 

the back of the printer. 

 
7. When the green LED light stops blinking and remains illuminated for approximately 10 seconds, 

remove the Product Enablement Key from the card reader slot. 
8. Touch Continue. 
9. Configure settings as needed, then to restart the printer and save your settings, touch Restart. To 

adjust your settings, touch Back. 
10. When the Services screen appears, the printer is ready for use. 

If the printer prompts you for Supplies Plan Activation during setup, enter your activation code. 
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Connecting the Printer 

This section includes: 
• Selecting a Connection Method .................................................................................................................................... 38 
• Physically Connecting the Printer to the Network ................................................................................................. 39 
• Connecting to a Computer Using USB ....................................................................................................................... 39 
• Connecting to a Telephone Line .................................................................................................................................... 39 
• Turning the Printer On and Off ...................................................................................................................................... 40 
 

Selecting a Connection Method 

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you 
select depends on how your computer is connected to the network. A USB connection is a direct 
connection and is the easiest to set up. An Ethernet connection is used for networking. If you are using a 
network connection, it is important to understand how your computer is connected to the network. For 
details, see About TCP/IP and IP Addresses on page 41. 

Notes: 

• Not all options listed are supported on all printers. Some options apply only to a specific printer 
model, configuration, operating system, or driver type. 

• Hardware and cabling requirements vary for the different connection methods. Routers, 
network hubs, network switches, modems, Ethernet cables, and USB cables are not included 
with your printer and must be purchased separately. 

• Network: If your computer is connected to an office network or home network, use an Ethernet 
cable to connect the printer to a network port. Ethernet networks can support many computers, 
printers, and devices simultaneously. In most cases, Ethernet connection is faster than USB and 
provides direct access to printer settings using CentreWare Internet Services. 

• Wireless Network: If your computer includes a wireless router or wireless access point, you can 
connect the printer to the network with a wireless connection. A wireless network connection 
provides the same access and services as a wired connection provides. A wireless network 
connection is typically faster than USB and allows direct access to the setting of the printer using 
CentreWare Internet Services. 

• USB: If you connect the printer to one computer and do not have a network, use a USB connection. 
A USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In 
addition, a USB connection does not provide access to CentreWare Internet Services. 

• Telephone: To send and receive faxes, the multifunction printer must be connected to a dedicated 
telephone line.  

 



Installation and Setup 

 

 Xerox® WorkCentre® 4265 Multifunction Printer 39 
 User Guide 
 

Physically Connecting the Printer to the Network 

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is 
used for one or more computers and supports many printers and systems simultaneously. An Ethernet 
connection provides direct access to printer settings using CentreWare Internet Services. 

To connect the printer: 
1. Connect the power cord to the printer, and plug the cord into an electrical outlet. 
2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer. 

Connect the other end of the Ethernet cable to a correctly configured network port on a hub or 
router. 

3. Turn on the printer. 
 

Note: For details on configuring wireless network settings, see the System Administrator Guide at 
www.xerox.com/office/WC4265docs. 

 
 

Connecting to a Computer Using USB 

To connect using USB, you need Windows XP SP3, Windows 7, Windows 8 or later, Windows Server 2003 
or later, or Macintosh OS X version 10.5 or later. 

To connect the printer to the computer using a USB cable: 
1. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the left side of the printer. 
2. Connect the A end of the USB cable to the USB port on the computer. 
3. If the Windows Found New Hardware Wizard appears, cancel it. 
4. Install the print drivers. For details, see Installing the Software on page 43. 
 

Connecting to a Telephone Line 
Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or driver type. 

1. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on 
the back of the printer. 

2. Connect the other end of the RJ11 cable to an operating telephone line. 
3. Enable and configure the Fax functions. 

For details, see the System Administrator Guide at www.xerox.com/office/WC4265docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
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Turning the Printer On and Off 

The printer has a Power Down button on the touch screen and a power switch on the left side. ThePower 
Down button on the touch screen initiates an orderly shutdown of the printer electronic components The 
power switch on the side of the printer controls the main power to the printer. 

To turn on the printer: 
1. Turn on the power switch. 

 
• If the power switch is on, but the printer is powered off, the printer was turned off using the control 

panel. To turn on the printer, flip the power switch first to the Off position and then to the On 
position. 

To turn off the printer: 
1. At the printer control panel, press the Power Saver button. 

Touch Power Down. 
 

 CAUTIONS: 

• To prevent a printer malfunction, perform the control panel shutdown first. 
• Do not plug or unplug the power cord while the printer is powered on. 

 

Note: When all of the control panel lights are off, the printer power off sequence is complete. 
Turning the power switch off is optional. 
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Configuring Network Settings 

This section includes: 
• About TCP/IP and IP Addresses ..................................................................................................................................... 41 
 

About TCP/IP and IP Addresses 

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a 
network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does 
not require printers or computers to have IP addresses. 

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and 
cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically assigns an IP address to every computer and printer on the network that is configured to 
use DHCP. 

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing. 
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Enabling the Printer for Scanning 

If the printer is connected to a network, you can scan to any of the following locations. 
• FTP 
• SMB 
• HTTP 
• HTTPS 
• SFTP 
• An email address 
• A shared folder on your computer 

For details, see CentreWare Internet Services on page 29. 

Note: If your printer is connected using the USB cable, you cannot scan to an email address or a 
network location, such as a shared folder on your computer. 

For details, see the System Administrator Guide at www.xerox.com/office/WC4265docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
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Installing the Software 

This section includes: 
• Operating System Requirements .................................................................................................................................. 43 
• Installing Drivers and Utilities for Windows ............................................................................................................. 43 
• Installing Print Drivers for Macintosh OS X Version 10.7 and Later ............................................................... 44 
• Installing Scan Drivers for Macintosh ......................................................................................................................... 45 
• Installing the Print Drivers for UNIX and Linux ...................................................................................................... 46 
• Other Drivers .......................................................................................................................................................................... 46 

Before you install driver software, verify that the printer is plugged in, turned on, connected correctly, 
and has a valid IP address. If you cannot find the IP address, see Finding the IP Address of Your Printer 
on page 30. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/WC4265drivers. 
 

Operating System Requirements 
• Windows XP SP3, Windows Vista, Windows 7, Windows 8, Windows Server 2003, Windows 

Server 2008, Windows Server 2008 R2, and Windows Server 2012. 
• Macintosh OS X version 10.5 and later 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. For details, see www.xerox.com/office/WC4265drivers. 
 

Installing Drivers and Utilities for Windows 

To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver. 

To install the print and scan driver software: 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. The 

installer starts automatically. 
If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. To change the language, click Language. 
3. Select your language, then click OK. 
4. Click Install Drivers > Install Print and Scan Drivers. 
5. To accept the license agreement, click I Agree. 
6. From the list of discovered printers, select your printer, then click Next. 
7. If your printer does not appear in the list of discovered printers, click Extended Search. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=driver&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=driver&Language=English
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8. If your printer still does not appear in the list of discovered printers, and you know the IP address: 
a. Click the Network Printer icon at the top of the window. 
b. Enter the IP address or the DNS name of the printer. 
c. Click Search. 
d. From the list of discovered printers, select your printer, then click Next. 

9. If the printer still does not appear in the list of discovered printers, and you do not know the IP 
address: 
a. Click Advanced Search. 
b. If you know the gateway address and subnet mask, click the top button and enter the 

addresses into the Gateway and Subnet Mask fields. 
c. If you know the address of another printer on the same subnet, click the middle button and 

enter the address in the IP Address field. 
d. Click Search. 
e. From the list of discovered printers, select your printer, then click Next. 

 

Note: When the printer appears in the Discovered Printers window, it displays the IP address. Record 
the IP address for future use. 

 

10. Select the desired driver. 
11. Click Install. 

If the installer prompts you for the IP address, enter the IP address of the printer. 
If the installer prompts you to restart your computer, click Restart to complete the installation of 
the drivers. 

12. To complete the installation, click Finish. 
 

Installing Print Drivers for Macintosh OS X Version 10.7 and Later 

Install the Xerox print driver to access all features of your printer. 

To install the print driver software: 
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1. Insert the Software and Documentation disc into the appropriate drive on your computer. 
2. To view the .dmg file for your printer, double-click the disc icon on your desktop. 
3. Open the .dmg file, then navigate to the appropriate installer file for your operating system. 
4. To begin installation, open the Installer package file. 
5. To acknowledge the warning and introductory messages, click Continue. Click Continue again. 
6. To accept the license agreement, click Continue, then click Agree. 
7. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
8. Enter your password, then click Install Software. 
9. Select your printer in the list of discovered printers, then click Continue. 
10. If your printer does not appear in the list of discovered printers: 

a. Click the Network Printer Icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

11. To accept the print queue message, click Continue. 
12. To accept the installation success message, click Close. 

To verify that the print driver recognizes the installed options: 
1. From the Apple menu, click System Preferences > Printers and Scanners. 
2. Select the printer from the list, then click Options & Supplies. 
3. Click Options. 
4. Confirm that all of the options installed on the printer appear correct. 
5. If you change settings, click OK, close the window, then exit System Preferences. 
 

Installing Scan Drivers for Macintosh 

To install the scan driver software: 
1. To download the latest driver, go to www.xerox.com/office/WC4265drivers. 
2. Download the appropriate package for your operating system. 
3. To view the .dmg file for your printer, double-click the disc icon on your desktop. 
4. Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your operating 

system. 
5. Open the Scan Installer package file. 
6. To acknowledge the warning and introductory messages, click Continue. 
7. To accept the license agreement, click Continue, then click Agree. 
8. Click Continue again. 
9. Enter your password, then click OK. 
10. If prompted to close other installations, click Continue Installing. 
11. To restart, click Log Out. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=driver&Language=English
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Installing the Print Drivers for UNIX and Linux 

To install the UNIX print drivers on your computer, you require root or superuser privileges. 

Notes: 

• This procedure requires an Internet connection. 
• To install Linux drivers, perform the following steps, then select Linux instead of UNIX for the 

operating system and package. 

To install the print driver software: 
1. At the printer, do the following: 

a. Verify that the TCP/IP protocol is enabled and the network cable is installed. 
b. On the printer control panel, for the IP address, do one of the following: 

• Allow the printer to set up a DHCP address. 
• Enter the IP address manually. 

2. Print the configuration page and keep it for reference. For details on how to print the configuration 
page, see Information Pages on page 27. 

3. At your computer, do the following: 
a. From the print driver website for your printer, select your printer model. 
b. From the Operating System menu, select UNIX, then click Go. 
c. Select the appropriate package for your operating system. 
d. To begin downloading, click the Start button. 

4. In the notes below the driver package that you selected, click the Installation Guide link, then 
follow the installation instructions. 

 

Other Drivers 

The following drivers are available for download at www.xerox.com/office/WC4265drivers. 
• The Xerox® Global Print Driver works with any printer on your network, including those printers 

made by other manufacturers. It configures itself for your individual printer upon installation. 
• The Xerox® Mobile Express Driver works with any printer available to your computer that supports 

standard PostScript. It configures itself for the printer you select every time you print. If you travel 
frequently to the same sites, you can save your favorite printers in that location and the driver saves 
your settings. 
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Installing the Printer as a Web Service on 
Devices 

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated 
services across a network. WSD supports device discovery, control, and use. 

To install a WSD printer using the Add Device Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Device Wizard, click Add a Device. 
3. In the list of available devices, select the one you want to use, then click Next. 

Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the 
WSD printer manually using the Add Printer Wizard. 

4. Click Close. 

To install a WSD printer using the Add Printer Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Printer Wizard, click Add a Printer. 
3. Click Add a network, wireless, or Bluetooth printer. 
4. In the list of available devices, select the one you want to use, then click Next. 
5. If the printer that you want does not appear in the list, click The printer that I want is not listed. 
6. Select Add a printer using a TCP/IP address or hostname, then click Next. 
7. For the Device type field, select Web Services Device. 
8. Enter the printer IP address in the Hostname or IP address field, then click Next. 
9. Select an option for sharing the printer with others in your network. 
10. For sharing, enter a share name, location, and comments to identify the printer, then click Next. 
11. To set the printer as the default, select an option. To test the connection, click Print a Test Page. 
12. Click Finish. 
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Supported Paper 

This section includes: 
• Ordering Paper ...................................................................................................................................................................... 50 
• General Paper Loading Guidelines................................................................................................................................ 50 
• Paper That Can Damage Your Printer ........................................................................................................................ 51 
• Paper Storage Guidelines ................................................................................................................................................. 51 
• Supported Paper Types and Weights .......................................................................................................................... 52 
• Supported Standard Paper Sizes ................................................................................................................................... 53 
• Supported Custom Paper Sizes ...................................................................................................................................... 53 
• Supported Paper Types and Weights for Automatic 2-Sided Printing .......................................................... 54 
• Supported Standard Paper Sizes for Automatic 2-Sided Printing ................................................................... 54 
• Supported Custom Paper Sizes for Automatic 2-Sided Printing ...................................................................... 54 
• Supported Paper for Automatic Stapling .................................................................................................................. 54 

Your printer is designed to use various paper and other media types. To ensure the best print quality and 
to avoid jams, follow the guidelines in this section. 

For best results, use Xerox paper and media recommended for your printer. 
 

Ordering Paper 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC4265supplies. 
 

General Paper Loading Guidelines 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper or other approved media from a new package. 
• Use only recommended Xerox® transparencies. Print quality could vary with other transparencies. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage 
your printer. Do not use the following: 
• Rough or porous paper 
• Plastic media other than supported transparencies 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Iron on transfer paper 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or special media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Contact your Xerox representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 

moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or 
gain. 

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Paper Types and Weights 

Paper Tray Paper Types Weight 

Bypass Tray 

Tray 1 with 520-sheet capacity 
Optional Trays 2-4 with 520-sheet capacities 

Plain 
Lightweight 
Bond 
Hole Punched 
Pre-Printed 
Recycled 
Envelope 
Transparency 
Labels 
Cardstock 
Cotton Letterhead 

70–90 g/m² 
60–69 g/m² 
105–120 g/m² 
60–90 g/m² 
75–85 g/m² 
60–85 g/m² 
75–90 g/m² 
138–146 g/m² 
120–150 g/m² 
90–163 g/m² 
90 g/m² 

Optional 2100-Sheet High-Capacity Feeder  Plain 
Lightweight 
Bond 
Hole Punched 
Pre-Printed 
Recycled 
Cardstock 
Cotton Letterhead 

70–90 g/m² 
60–69 g/m² 
105–120 g/m² 
60–90 g/m² 
75–85 g/m² 
60–85 g/m² 
90–163 g/m² 
90 g/m² 
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Supported Standard Paper Sizes 
 

Tray European Standard Sizes North American Standard Sizes 

Tray 1 and 
optional Trays 
2-4 

A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
ISO B5 (176 x 250 mm, 6.9 x 9.8 in.) 
A6 (105 x 148 mm, 4.1 x 5.8 in.) 
C5 envelope (162 x 229 mm, 6.4 x 9 in.) 
C6 envelope (114 x 162 mm, 4.5 x 6.38 in.) 
DL envelope (110 x 220 mm, 4.33 x 8.66 in.) 
 

Letter (216 x 279 mm, 8.5 x 11 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Oficio (216 x 343 mm, 8.5 x 13.5 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Postcard (102 x 152 mm, 4 x 6 in.) 
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.) 
Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.) 

Optional 
2100-Sheet 
High-Capacity 
Feeder  

A5 (148 x 210 mm, 5.8 x 8.3 in.) 
ISO B5 (176 x 250 mm, 6.9 x 9.8 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
 

Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Oficio (216 x 343 mm, 8.5 x 13.5 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 

Bypass Tray A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
ISO B5 (176 x 250 mm, 6.9 x 9.8 in.) 
A6 (105 x 148 mm, 4.1 x 5.8 in.) 
C5 envelope (162 x 229 mm, 6.4 x 9 in.) 
C6 envelope (114 x 162 mm, 4.5 x 6.38 in.) 
DL envelope (110 x 220 mm, 4.33 x 8.66 in.) 
Postcard (100 x 148 mm, 3.9 x 5.8 in.) 

Letter (216 x 279 mm, 8.5 x 11 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Oficio (216 x 343 mm, 8.5 x 13.5 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Postcard (102 x 152 mm, 4 x 6 in.) 
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.) 
Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.) 
Postcard (102 x 152 mm, 4 x 6 in.) 

  
 

Supported Custom Paper Sizes 
 

Tray Width Length 

Trays 1-4 and Bypass Tray Only 98–216 mm (3.9–8.5 in.) 148–356 mm (5.8–14 in.) 

All Trays 182–216 mm (7.2–8.5 in.) 152.4–356 mm (6–14 in.) 
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Supported Paper Types and Weights for Automatic 2-Sided Printing 
 

Paper Type Weight 

Lightweight 60–70 g/m² 

Recycled 60–85 g/m² 

Plain 
Letterhead 
Hole Punched 

70–90 g/m² 

Pre-Printed 75–85 g/m² 
 
 

Supported Standard Paper Sizes for Automatic 2-Sided Printing 
 

European Standard Sizes North American Standard Sizes 

A4 (210 x 297 mm, 8.3 x 11.7 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
ISO B5 (176 x 250 mm, 6.9 x 9.8 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 

Legal (216 x 356 mm, 8.5 x 14 in.) 
Oficio (216 x 343 mm, 8.5 x 13.5 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
Statement (140 x 216 mm, 5.5 x 8.5 in.) 

 
 

Supported Custom Paper Sizes for Automatic 2-Sided Printing 
 

Tray Width Length 

Trays 1-4 and Bypass Tray Only 98–216 mm (3.9–8.5 in.) 148–356 mm (5.8–14 in.) 

All Trays 98–216 mm (3.9–8.5 in.) 152.4–356 mm (6–14 in.) 
 
 

Supported Paper for Automatic Stapling 

The following standard paper types are supported for automatic stapling. 
 

Paper Type Weight 

Lightweight 60–70 g/m² 

Recycled 60–85 g/m² 

Plain 
Letterhead 
Hole Punched 
Custom 

70–90 g/m² 

Pre-Printed 75–85 g/m² 

Bond 105–120 g/m² 

Lightweight Cardstock 106–163 g/m² 
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The following standard paper sizes are supported for automatic stapling. 
 

European Standard Sizes North American Standard Sizes 

A4 (210 x 297 mm, 8.3 x 11.7 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 

Legal (216 x 356 mm, 8.5 x 14 in.) 
Oficio (216 x 343 mm, 8.5 x 13.5 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 

Custom paper sizes within the following ranges are supported for automatic stapling. 
 

Tray Width Length 

Tray 1 and Bypass Tray 182–216 mm (7.2–8.5 in.) 148–356 mm (5.8–14 in.) 

Trays 1 and 2 182–216 mm (7.2–8.5 in.) 152.4–356 mm (6–14 in.) 
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Loading Paper 

This section includes: 
• Loading Paper in the Bypass Tray ................................................................................................................................ 56 
• Loading Paper in a 520-Sheet Feeder (Trays 1-4) ................................................................................................. 58 
• Loading Paper in the 2100-Sheet High-Capacity Feeder ................................................................................... 60 
 

Loading Paper in the Bypass Tray 

To load paper in the bypass tray: 
1. Open the bypass tray. 
2. If the bypass tray is loaded with paper already, remove any paper that is a different size or type. 

 
3. Move the width guides to the edges of the tray. 
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4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

5. Load the paper in the tray. 
6. Load hole punched paper with the holes toward the rear of the printer. 

 
7. For 1-sided and 2-sided printing, to load letterhead or pre-printed paper, place letterhead face down 

with the top edge going into the printer. 

 
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 

8. Adjust the width guides until they touch the edges of the paper. 

 
9. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
10. When finished, touch Confirm. 
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Loading Paper in a 520-Sheet Feeder (Trays 1-4) 

To load paper in a 520-sheet feeder: 
1. Pull out the tray until it stops. 

 
2. Move the length and width guides out: 

a. Pinch the guide lever on each guide. 
b. Slide the guides outward until they stop. 
c. Release the levers. 

     
3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 
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4. Load the paper with the short edge against the right side of the tray. 

Notes: 

• Load paper into the tray with the print side face up. 
• Load hole punched paper with the holes toward the rear of the printer. 
• Do not load paper above the maximum fill line. Overfilling can cause paper jams. 

 
5. Adjust the paper guides in the tray to match the size of the paper. 

     
6. Close the tray. 

 
7. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
8. Touch Confirm. 
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Loading Paper in the 2100-Sheet High-Capacity Feeder 

To load paper in the high-capacity feeder: 
1. Pull out the tray until it stops. 

 
2. To unlock the paper guides, lift, turn, then remove the locking pins from the side paper guides. 
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3. To adjust the size, slide the paper guides until the arrow aligns to the required paper size. In this 
example, the guide is locked to fit JIS B5 paper. 

 
4. To lock the paper guides in place, insert the locking pins into the desired slot, then turn pins to the 

left until they fit snugly. 

 
 

 CAUTION: If you force the pin into place, it can result in breakage. 
 

5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 
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6. Load the paper with the short edge against the right side of the tray. 

Notes: 

• Load paper into the tray with the print side face down. 
• Load hole punched paper with the holes toward the rear of the printer. 
• Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 

jam. 

 
7. Close the tray. 

 
8. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
9. When finished, touch Confirm. 
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Printing on Special Paper 

This section includes: 
• Envelopes ................................................................................................................................................................................. 63 
• Guidelines for Printing Envelopes ................................................................................................................................. 63 
• Loading Envelopes in a 520-Sheet Feeder (Trays 1-4) ........................................................................................ 64 
• Loading Envelopes in the Bypass Tray ........................................................................................................................ 65 
• Labels ........................................................................................................................................................................................ 66 
• Transparencies ...................................................................................................................................................................... 67 

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/WC4265supplies. 
 

Envelopes 

You can print envelopes from the bypass tray or a 520-sheet feeder only. For details, see Supported 
Standard Paper Sizes on page 53. 
 

Guidelines for Printing Envelopes 
• Print quality depends on the quality and construction of the envelopes. Try another envelope brand 

if you do not get desired results. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect 

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book 
on top of them. 

• In the print driver software, select Envelope as the paper type. 
• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
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Loading Envelopes in a 520-Sheet Feeder (Trays 1-4) 

To load envelopes in a 520-sheet feeder: 
1. Pull out the tray until it stops. 
2. Remove any paper left in the tray. 
3. Load the envelopes in the tray with the flaps closed, flap-side down, flaps toward the rear of the 

tray. 

 
4. Adjust the paper guides so they rest lightly against the edges of the envelopes. 

    
5. Close the tray. 
6. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
7. When finished, touch Confirm. 
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Loading Envelopes in the Bypass Tray 
1. Open the bypass tray. 

 
2. Move the width guides to the edges of the tray. 

 
Note: If you do not load envelopes in the bypass tray right after they have been removed from the 
packaging, they can bulge. Flatten them to avoid jams. 

 
3. To load envelopes with long-edge flaps, place the envelopes with the short edge going into the 

printer, flaps up, and to the right. 
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4. For envelopes with adhesive short-edge flaps, load the envelopes with the print side down, flaps 
closed, and flaps feeding into the printer. 

 
5. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
6. When finished, touch Confirm. 
 

Labels 

You can print labels from any tray. 
 

Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 

packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 

• In the print driver software, select Label as the paper type. 
• Before loading labels, remove all other paper from the tray. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing 
sheet. It could damage the printer. 
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Loading Labels in a 520-Sheet Feeder (Trays 1-4) 

To load labels in a 520-sheet feeder: 
1. Remove all paper from the tray. 
2. Load the labels face up with the top edge to the right. 

 
3. Adjust the guides until they touch the edges of the paper. 
4. Close the tray. 
5. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
6. When finished, touch Confirm. 
 

Transparencies 

You can print transparencies from the bypass tray or from Trays 1-4. 
 

Guidelines for Printing Transparencies 
• Remove all paper before loading transparencies in the tray. 
• Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print 

quality. 
• After loading transparencies, change the paper type to Transparency on the printer control panel. 
• In the print driver software, select Transparency as the paper type. 
• Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam. 
• Do not fan transparencies. 
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This chapter includes: 
• Printing Overview ................................................................................................................................................................. 70 
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• Managing Jobs ...................................................................................................................................................................... 76 
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• Held Print Jobs ....................................................................................................................................................................... 84 
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected to an 
active network. Make sure that you have the correct print driver software installed on your computer. For 
details, see Installing the Software on page 43. 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. 
3. At the printer control panel, specify the size and type. 
4. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
5. Select your printer. 
6. To access the print driver settings for Windows, select Properties or Preferences. For Macintosh 

select Xerox® Features. 
7. Select the desired options. 
8. Click Print to send the job to the printer. 
  

See also: 
Loading Paper on page 56 
Selecting Printing Options on page 71 
Printing on Both Sides of the Paper on page 78 
Printing on Special Paper on page 63 
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Selecting Printing Options 

This section includes: 
• Print Driver Help .................................................................................................................................................................... 71 
• Windows Printing Options ................................................................................................................................................ 72 
• Macintosh Printing Options ............................................................................................................................................. 73 
• Linux Printing Options ........................................................................................................................................................ 74 

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printers and Faxes Printing Preferences 
become the default setting. Printing options that are set from within the software application are 
temporary. The application and the computer do not save the settings after the application is closed. 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences appears in the Help window on two tabs: 
• Contents provides a list of the tabs at the top and the areas at the bottom of the Printing 

Preferences window. Use the Contents tab to find explanations for each of the fields and areas in 
Printing Preferences. 

• Search provides a field where you can enter the topic or function for which you need information. 
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Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 

To select default printing options: 
1. Navigate to the list of printers on your computer: 

− For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 
− For Windows Server 2003 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Control Panel > Devices and Printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then 
select Personalize > Control Panel Home > Devices and Printers. 

2. In the list, right-click the icon for your printer and click Printing Preferences. 
3. In the Printing Preferences window, click a tab, select the options, then click OK to save. 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 

 

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, you can change the Printing Preferences before 
sending the job to the printer. For example, if you want the highest print quality when you print a 
document, in Printing Preferences, select High Resolution, then submit the print job. 
1. With the document open in your software application, access the print settings. For most software 

applications, click File > Print or press CTRL+P. 
2. To open the Properties window, select your printer, then click the Properties or Preferences button. 

The title of the button varies depending on your application. 
3. Click a tab in the Properties window, then make selections. 
4. To save your selections and close the Properties window, click OK. 
5. To send the job to the printer, click OK. 
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Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select the printer, then click Properties. Click the tabs in the Properties window, then select the 

desired settings. 
3. To save the settings, click the arrow to the right of the Saved Settings field at the bottom of the 

window, then click Save As. 
4. Type a name for the set of printing options, then to save the set of options in the Saved Settings list, 

click OK. 
5. To print using these options, select the name from the list. 
 

Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print. 
2. Select your printer. 
3. Select Xerox® Features. 
4. Select the desired options. 
5. Click Print. 
 

Selecting Finishing Options for Macintosh 

If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver. 

To select finishing options in the Macintosh print driver: 
1. With the document open in your application, click File > Print. 
2. Select Xerox® Features. 
3. To select stapling options, click the arrow to the right of the Finishing field, then select an option. 
4. To select the output tray, click the arrow to the right of the Output Destination field, then select an 

option: 
− Automatically Select determines the output destination by the number of sets and the 

stapling option selected. Multiple sets or stapled sets are sent to the finisher output tray. 
− Top Tray selects the output tray on top of the printer. 
− Stacker Tray selects the finisher output tray. 

5. To send the job to the printer, click OK. 
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Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. In the printer list, select your printer. 
3. Select the desired printing options. 
4. To save the settings, select Save Current Settings as Preset. 
 

Linux Printing Options 

Launching Xerox® Printer Manager 

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press 
Enter or Return. 
 

Printing from a Linux Workstation 

The Xerox® print driver accepts a job ticket setting file that contains preset printing features. You can 
also submit print requests through the command line using lp/lpr. For more information about Linux 
printing, click the Help (?) button in the Xerox® GUI print driver. 

To print from a Linux workstation: 
1. Create a print queue. 
2. With the desired document or graphic open in your application, open the Print dialog box. For most 

software applications, click File > Print or press CTRL+P. 
3. Select the target print queue. 
4. Close the Print dialog box 
5. In the Xerox® GUI print driver, select the available printer features. 
6. Click Print. 

To create a job ticket using the Xerox® GUI print driver: 
1. Open the Xerox® GUI print driver. 

Note: To open the Xerox® GUI print driver, as root, type xeroxprtmgr. 

2. On the My Printers screen, select the printer. 
3. In the top corner, click Edit Printer, then select options for the print job. 
4. Click Save As, then store the job ticket in your home directory. 

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job 
ticket. You can specify the information on the command line. 

To print using the job ticket, type the command lp -d{Target_Queue} - oJT=<path_to_ticket> 
<file_name>. 
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The following commands are examples of how to print using a job ticket: 
• lp -d{Target_Queue} -oJT={Absolute_Path_To_Job_Ticket} {Path_To_Print_File} 
• lp -dMyQueue -oJT=/tmp/DuplexedLetterhead /home/user/PrintReadyFile 
• lp -dMyQueue -oJT=/tmp/Secure -oSecurePasscode=1234 /home/user/PrintReadyFile 
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Managing Jobs 

This section includes: 
• Managing Jobs at the Control Panel ........................................................................................................................... 76 
• Managing Secure and Held Print Jobs ........................................................................................................................ 77 
• Managing Jobs in CentreWare Internet Services ................................................................................................... 77 
 

Managing Jobs at the Control Panel 

From the control panel Job Status, you can view lists of active jobs, secure jobs, or completed jobs. You 
can pause, delete, print, or view job progress or job details for a selected job. For details, see Printing 
Special Job Types on page 81. 

To pause and restart printing: 
1. To pause printing, at the control panel, press the Interrupt Printing button. 
2. To resume printing, press the Interrupt Printing button. 

To pause the print job with the option to delete it: 
1. At the control panel, press the Stop button. 
2. To resume the print job, touch Resume. 
3. To delete the print job, touch Cancel. 

To view active, secure, or completed jobs: 
1. At the control panel, press the Job Status button. 
2. To see a list of specific job types, touch a tab. 

− To view jobs that are in process or waiting to process, touch the Active Jobs tab. 
− To view Secure Print jobs, touch the Personal & Secure Jobs tab. Touch the folder, enter the 

passcode number, then touch OK. 
− To view completed jobs, touch the Completed Jobs tab. 

3. To see details about a job, touch the job. 

To delete a job: 
1. At the control panel, press the Job Status button. 
2. From any of the job type tabs, touch the job. 
3. Touch Delete. 

Notes: 

• The system administrator can restrict users from deleting jobs. If a system administrator has 
restricted job deletion, you can view the jobs, but not delete them. 

• Only the user that sent the job or the system administrator can delete a secure print job. 
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From the Print From menu, you can view lists of saved jobs, jobs stored on a USB Flash drive, or jobs 
stored in printer folders. You can select and print jobs from any of the lists. To print the job, see Printing 
Special Job Types on page 81. 

To reprint saved jobs: 

At the control panel, press the Services button, then touch Reprint Saved Jobs. 
 

Managing Secure and Held Print Jobs 

When you send a secure print job, the job is held until you release it by typing a passcode at the control 
panel. 

To view a list of secure print jobs: 
1. At the printer control panel, press the Job Status button. 
2. Touch Personal & Secure Print Jobs. 

Note: Only the user that sent the job or the system administrator can delete a secure print job. 

If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is held 
until you release it. For details, see Releasing Held Print Jobs on page 84. 

Unidentified jobs are jobs that are not associated with a user name. Unidentified jobs originate from a 
computer that does not require a user to log in. Examples are a job sent from a DOS or UNIX window 
using LPR, Port 9100, or from the Jobs tab in CentreWare Internet Services. 

To view a list of the unidentified jobs and release them: 
1. Touch the Unidentified Jobs tab. 
2. To release a held job, touch the job, then touch Release. 
3. To release all held jobs, touch Release All Jobs. 

If the printer is unable to complete a print job, it holds the job. Once the condition resolves, the printer 
resumes printing automatically. 
 

Managing Jobs in CentreWare Internet Services 

You can view a list of active jobs and delete print jobs from the Active Jobs list in CentreWare Internet 
Services. You can also print, copy, move, or delete saved jobs. For details, see the Help in CentreWare 
Internet Services. 
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Printing Features 

This section includes: 
• Printing on Both Sides of the Paper ............................................................................................................................. 78 
• Selecting Paper Options for Printing ............................................................................................................................ 79 
• Printing Multiple Pages to a Single Sheet.................................................................................................................. 79 
• Scaling ...................................................................................................................................................................................... 79 
• Printing Booklets................................................................................................................................................................... 80 
• Print Quality ............................................................................................................................................................................ 80 
 

Printing on Both Sides of the Paper 

Paper Types for Automatic 2-Sided Printing 

The printer can print a 2-sided document automatically on supported paper. Before printing a 2-sided 
document, verify that the paper type and weight are supported. For details, see Supported Paper Types 
and Weights for Automatic 2-Sided Printing on page 54. 
 

Printing a 2-Sided Document 

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the settings 
for portrait or landscape orientation from the application for printing the document. 
 

2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. 
These settings override the application page orientation settings. 
 

Portrait Landscape 
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2-Sided Print 

Portrait 
2-Sided Print, Flip on Short 
Edge 

Landscape 
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Landscape 
2-Sided Print, Flip on Short 
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Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to 
use based on the document size, paper type, and paper color you specify. You can also select a specific 
tray loaded with the desired paper. 
 

Printing Multiple Pages to a Single Sheet 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 
Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout 
is on the Document Options tab. 

 
 

Scaling 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. In 
Windows, you can find the Scale Options in the print driver on the Printing Options tab. 
 

50% 100% 200% 
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To access the Scale options, click the arrow at the right side of the Paper field, then select Other Size. 
• No Scaling does not increase or decrease the size of the image from the original. 
• Automatically Scale changes the print from one standard paper size to another standard paper 

size. The Original Document Size is scaled to fit on the selected output paper size shown in the 
Output Paper Size field. 

• Manually Scale changes the output print size by the percentage entered into the field under the 
graphic to the right of the Scale Options. 

 

Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any 
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and 
prints four page images per sheet of paper, two page images on each side. The pages are printed in the 
correct order so that you can fold and staple the pages to create the booklet. 

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm 

(1/72 in.). 
• Creep: Specifies how much the page images shift outward in tenths of a point. Shifting 

compensates for the thickness of the folded paper, which can cause the page images to shift 
outward slightly when folded. You can select a value from zero to 1 point. 

 

Gutter Creep 

 

 

 
 

 
 

Print Quality 

Print-quality modes: 
• Standard print-quality mode: 600 x 600 dpi 
• High Resolution print-quality mode: 1200 x 1200 dpi 
• Draft Mode saves toner or ink, producing lower-quality images. 

− This mode reduces the amount of toner used for print jobs. 
− You can use this feature for draft quality output. 
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Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 
 

Secure Print 

Secure print allows you to associate a 4–10 digit passcode with a print job when sending it to the printer. 
The job is held at the printer until you enter the passcode at the control panel. 

When printing a series of secure print jobs, you can assign a default passcode in the Printing Preferences 
of the print driver. Then you can use the default passcode for all print jobs sent from that computer. If 
you must use a different passcode, you can override it in the application print driver. 
 

Releasing a Secure Print 
1. At the printer control panel, press the Job Status button. 
2. Touch the Personal & Secure Jobs tab. 
3. Touch the folder that holds the print job. 
4. Enter the passcode number that you assigned to the print job using the keypad. 
5. Touch the corresponding print job in the list, then touch Print. 
 

Deleting a Secure Print 
1. At the control panel, press the Job Status button. 
2. Touch the Personal & Secure Jobs tab. 
3. Touch the folder that holds the print job. 
4. Enter the passcode number that you assigned to the print job using the keypad. 
5. Touch OK. 
6. Touch the corresponding print job in the list, then touch Delete. 
 

Personal Print Job 

Use the Personal Print job type to save a print job under your user name and print it from the printer 
control panel. You do not need to enter a job name or passcode. 
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Releasing a Personal Print Job 
1. At the printer control panel, press the Job Status button. 
2. Touch the Personal & Secure Jobs tab. 
3. Touch the folder that holds the print job. 
4. Touch Skip Passcode, then touch OK. 
5. Touch the corresponding print job in the list, then touch Print. 
 

Deleting a Personal Print 
1. At the control panel, press the Job Status button. 
2. Touch the Personal & Secure Jobs tab. 
3. Touch the folder that holds the print job. 
4. Touch the corresponding print job in the list, then touch Delete. 
 

Sample Set 

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the 
remaining copies at the printer. After you review the sample copy, you can select the job name from the 
printer control panel to print the additional copies. 
 

Releasing the Remaining Prints After Printing a Sample Set 
1. At the printer control panel, press the Job Status button. 
2. Touch the corresponding print job from the Active Jobs tab. 
3. Touch Release. 

The job prints, then is deleted from the printer hard drive. 
 



Printing 

 

 Xerox® WorkCentre® 4265 Multifunction Printer 83 
 User Guide 
 

Saved Jobs 

You can use the controls in the Saved jobs window to save the job, or you can print and save the job for 
future use. 
 

Printing from Saved Jobs 
1. At the control panel, press the Services button, then touch Reprint Saved Jobs. 
2. Touch the name of the saved job that you want to print. 
3. Touch OK. 
4. Select the number of copies. 
5. Press the green Start button. 
6. After the job prints, to return to the list of saved jobs, touch Browse. 
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Held Print Jobs 

Jobs can be held or paused for various reasons. For example, if the printer is out of paper, the job holds. 
If you send a sample job, the first copy of the job prints and the rest of the copies hold until you release 
them. If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is 
held until you release it. 
 

Releasing Held Print Jobs 
1. At the control panel, press the Job Status button. 
2. Touch Active Jobs. 
3. To determine why a job was held, touch the job, then touch Details. 
4. To release a held job, touch the job, then touch Release. 
5. To release all held jobs, touch Release All Jobs. 
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Printing from a USB Flash Drive 

You can print .pdf, .ps, .pcl, .prn, .tiff, and .xps files directly from a USB Flash drive. 

Notes: 

• If USB ports are disabled, you cannot use a USB card reader for authentication, update the 
software, or print from a USB Flash drive. 

• The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC4265docs. 

To print from a USB Flash drive: 
1. Insert your USB Flash drive in a USB port on the printer. The Print from USB window appears. 

The list at the bottom of the window displays the folders and printable files on the USB Flash drive. 
2. To scroll through the list and locate the printable file, next to the list, use the arrows. 
3. If the print file is in a folder, to open the folder, touch the name. 
4. Touch the name of the printable file. 
5. Select the number of copies, paper size, paper color, paper type, 2-sided printing, and finishing 

options. 
6. Press the green Start button. 
7. To go back to the last screen, touch Back. 
8. To look for other folders and printable files, touch Browse. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
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This chapter includes: 
• Basic Copying ........................................................................................................................................................................ 88
• Selecting Copy Settings ..................................................................................................................................................... 94

6 Copying 
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Basic Copying 

This section includes: 
• Document Glass .................................................................................................................................................................... 88
• Document Glass Guidelines ............................................................................................................................................. 89
• Document Feeder ................................................................................................................................................................ 89
• Document Feeder Guidelines .......................................................................................................................................... 89
• Adjusting Copying Options .............................................................................................................................................. 90
1. To clear previous settings, press the yellow Clear All button on the control panel.
2. Load your original documents:

− Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

− Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

3. Press the Services Home button, then touch Copy.
4. To enter the number of copies, use the alphanumeric keypad on the touch screen or the control

panel.
5. Change the copy settings as needed.
6. Press the green Start button.

Notes:

• To pause or cancel a copy job, press the red Stop button on the control panel.
• To interrupt a copy job, at the control panel, press the Interrupt Printing button.

Document Glass 

• Lift the document feeder cover and place the
first page face down in the upper left corner
of the document glass.

• Align the originals to the matching paper size
printed on the edge of the glass.

• The document glass accommodates original
sizes up to 216 x 356 mm (8.5 x 14 in.).

• The document glass automatically detects
Legal or Letter/A4 and smaller paper sizes.
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Document Glass Guidelines 

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.). 

To copy or scan the following types of originals, use the document glass rather than the duplex 
automatic document feeder. 
• Paper with paper clips or staples attached
• Paper with wrinkles, curls, folds, tears, or notches
• Coated or carbonless paper or items other than paper such as cloth or metal
• Envelopes
• Books

Document Feeder 

• Insert originals face up, with page one on top.
• Adjust the paper guides so they fit against the

originals.

• The document feeder accepts paper
weights from 50–105 g/m² (12.5–28 lb.)
for 2-sided pages.

• The document feeder accepts paper sizes from
145 x 145 mm (5.7 x 5.7 in.) through 216 x
356 mm (8.5 x 14 in.) for 1-sided pages, and
176 x 250 (6.93 x 9.84 in.) through 216 x
356 mm (8.5 x 14 in.) for 2-sided pages.

• The maximum feeder capacity is
approximately 100 sheets of 75 g/m² paper.

• The document feeder automatically detects
Legal or Letter/A4 size paper.

Document Feeder Guidelines 

When loading originals into the duplex automatic document feeder, follow these guidelines: 
• Insert originals face up with the top of the page entering the feeder first.
• Only place loose sheets of paper in the duplex automatic document feeder.
• Adjust the paper guides so that they fit against the originals.
• Only Insert paper in the duplex automatic document feeder when ink on the paper is dry.
• Do not load originals above the MAX fill line.
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Adjusting Copying Options 

This section includes: 
• Basic Settings ......................................................................................................................................................................... 91 
• Image-Quality Settings ..................................................................................................................................................... 92 
• Finishing ................................................................................................................................................................................... 93 

You can adjust numerous options for your copy jobs, specify characteristics of the original documents, 
and customize the output. For details, see Basic Copying on page 91. 

You can also modify the default settings for many options. For details, see Selecting Default Copy 
Settings on page 94. 
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Basic Settings 

This section includes: 
• Selecting a Paper Tray ....................................................................................................................................................... 91 
• Making the Image Lighter or Darker ........................................................................................................................... 91 
• Setting 2-Sided Copying ................................................................................................................................................... 91 
 

Selecting a Paper Tray 
1. At the printer control panel, press the Services Home button. 
2. Touch Copy. 
3. Touch the Copy tab. 
4. For Paper Supply, touch the desired tray. 
5. Touch OK. 
 

Making the Image Lighter or Darker 
1. At the printer control panel, press the Services Home button. 
2. Touch Copy. 
3. Touch More Features > Lighten/Darken. 
4. Adjust the sliders up or down as needed. 
5. Touch OK. 
 

Setting 2-Sided Copying 
1. At the printer control panel, press the Services Home button. 
2. Touch Copy. 
3. Under the Copy tab, touch 2-Sided Copying. 
4. Touch an option. 
5. Touch OK. 
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Image-Quality Settings 

This section includes: 
• Specifying the Original Type ........................................................................................................................................... 92 
• Adjusting Brightness ........................................................................................................................................................... 92 
• Automatically Suppressing Background Variation ................................................................................................ 92 
 

Specifying the Original Type 

The printer optimizes the image quality of the copies based on the type of images in the original 
document and how the original was created. 

To specify the original type: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Original Type. 
3. Select an option. 
4. Touch OK. 
 

Adjusting Brightness 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Lighten/Darken. 
3. Adjust the sliders up or down as needed. 
4. Touch OK. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To change this setting: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Background Suppression. 
3. Under Background Suppression, touch Auto Suppression. 
4. Touch OK. 
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Finishing 

Collated Copies 

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a 
six-page document, the copies are printed in this order: 

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6 

Uncollated copies print in the following order: 

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6 

To select Collate options: 
1. At the printer control panel, press the Services Home button. 
2. Touch Copy. 
3. Touch Finishing, then select an option. 

− Collated turns on collation for all copies made, regardless of where the originals are placed. 
− Uncollated turns off collation. 

 

Stapling Copies 

If your printer has a finisher, it can staple your copies. 

To select stapling: 
1. Press the Services Home button, then touch Copy. 
2. Touch Finishing, then select an option. 
3. Touch OK. 
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Selecting Copy Settings 

This section includes: 
• Output Adjustments ........................................................................................................................................................... 94 
• Output Format Settings .................................................................................................................................................... 96 
• ID Card Copying ................................................................................................................................................................... 98 
• Advanced Copying .............................................................................................................................................................. 99 
 

Output Adjustments 

Reducing or Enlarging the Image 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. 

To reduce or enlarge the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Reduce/Enlarge. 
3. Touch an option. 

− To reduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-). 
− To reduce or enlarge the percentage incrementally, touch the arrows. 
− To reduce or enlarge the percentage using the alphanumeric keypad, touch the current 

displayed value. 
4. Touch OK. 
 

Specifying the Size of the Original 

To scan the correct area of the original, specify the original size. 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Original Size. 
3. Touch an option. 

− Auto Detect: The printer detects the size of the original document. 
− Preset Scan Area: You can specify the area to scan when it matches a standard paper size. 
− Custom Scan Area: You can specify the height and width of the area to scan. 
− Mixed Size Originals: You can scan standard-size originals of varying sizes. 

4. Touch OK. 
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Erasing the Edges of Copies 

You can erase content from the edges of your copies by specifying the amount to erase on the right, left, 
top, and bottom edges. 

To erase edges on copies: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Edge Erase. 
3. Select an option. 
4. Touch OK. 
 

Page Layout 

You can use Page Layout to place a defined number of pages on one or both sides of the paper. 

Note: Page Layout is disabled unless a preset Original Size is selected. 

To specify the page layout: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Page Layout. 
3. Select an option. 
4. For Paper Supply, touch the desired tray. 
5. Touch OK. 
 

Shifting the Image 

You can change the placement of an image on the copy page. For Image Shift to function correctly, 
position originals as follows. 
• For the Document Feeder, position originals face up, short edge entering the feeder first. 
• For Document Glass, position originals face down in the back-left corner of the document glass with 

the short edge to the left. 

To change the placement of the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Image Shift. 
3. Select an option. 
4. Touch OK. 
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Output Format Settings 

This section includes: 
• Selecting Book Copying ..................................................................................................................................................... 96 
• Creating a Booklet ............................................................................................................................................................... 96 
• Including Covers ................................................................................................................................................................... 97 
• Adding Transparency Separators .................................................................................................................................. 97 
 

Selecting Book Copying 

When copying a book, magazine, or other bound document, you can copy either the left or right page 
onto a single sheet of paper. You can copy both the left and right pages onto two sheets of paper, or as 
a single image on one sheet of paper. 

Note: Book Copying is disabled unless a preset Original Size is selected. 

To set up book copying: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Book Copying. 
3. Touch an option, then touch OK. 
 

Creating a Booklet 

You can print copies in booklet format. The booklet feature reduces the original page images to fit two 
images on each side of the printed page. 

Note: In this mode, the printer scans all of the originals before printing the copies. 

To create a booklet: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features> Booklet Creation. 
3. Touch On. 
4. Make selections as needed. 
5. Touch OK. 
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Including Covers 

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight 
paper. The printer selects the paper from a different tray. The covers can be blank or printed. 

Notes: 
• Ensure that the paper used for the covers is the same as the paper used for the rest of the 

document. 
• If Booklet Creation is turned off or the paper supply is set to Auto Select, Covers Options are 

unavailable. 

To select the type of covers and the tray to use for the cover paper: 
1. Press the Services Home button, then touch Copy. 
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job. 
3. Touch OK. 
4. Touch More Features > Covers. 
5. Touch an option, then touch OK. 
 

Adding Transparency Separators 

You can add blank sheets of paper between each printed transparency. Ensure that the size and 
orientation of the separators is the same as the transparencies. 

Note: If the paper supply is set to Auto Select, you cannot add transparency separators. 

To add transparency separators: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Transparency Separators. 
3. Select an option. 

− Off: This option does not insert a page between the transparencies. 
− Blank: This option inserts a blank page between the transparencies. 
− Printed: This option inserts a printed sheet of paper between the transparencies. 

4. Under Paper Supply, touch the desired tray. 
5. Touch OK. 
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ID Card Copying 

You can copy both sides of an ID card or small document onto one side of paper. Each side is copied 
using the same location on the document glass. The printer stores both sides and prints them side by 
side on the paper. 

To copy an ID card: 
1. Press the Services Home button, then touch ID Card Copy. 
2. To change the options for paper supply, to lighten or darken an image or to turn on auto 

suppression, in the ID Card Copy screen, touch Edit. 
3. Lift the document cover. 
4. Place the ID card, or a document smaller than half the selected paper supply size, in the upper left 

corner of the document glass. 
5. To enter the number of copies, use the alphanumeric keypad on the touch screen or the control 

panel. 
6. Press the green Start button. 
7. Lift the document cover. 
8. Turn over the document and position it in the upper left corner of the document glass. 
9. Press the green Start button. 
10. Lift the document cover and remove the ID card or document. 
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Advanced Copying 

This section includes: 
• Building a Copy Job............................................................................................................................................................. 99 
 

Building a Copy Job 

Use this feature to produce complex copy jobs that include a variety of originals requiring different copy 
settings. Each segment of the job can have different copy settings. Once all the segments are 
programmed, scanned, and temporarily stored in the printer, the copy job prints. 

The Build Job screen displays information about the job such as the Segment #, Pages, and Quantity for 
Final Job. 

To build a copy job with multiple segments: 
1. Press the Services Home button, then touch Copy. 
2. Touch More Features > Build Job. 
3. Touch On. 
4. Touch Options. 

a. Select or clear the Display Summary window between segments check box. 
b. Select or clear the Turn Build Job Off after Job is Submitted check box. 

5. Touch OK. 
6. Program and copy the first segment. 

a. Load the originals for the first segment. 
b. Press the green Start button. 

7. If a password is required, contact the system administrator. 
8. Program and copy additional segments. 

a. Load the originals for the next segment. 
b. When the Build Job screen appears, touch Program Next Segment. 
c. Press the green Start button. 

9. Repeat the previous step for each remaining segment. 
10. At any time, you can touch Delete All Segments to modify the job. 
11. When all of the segments have been programmed and copied, touch Submit the Job. 

If necessary, touch Delete > Delete Job to cancel the job. 
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• Scanning to a Computer ................................................................................................................................................. 115

The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC4265docs. 

If the system administrator enables Remote Start in CentreWare Internet Services, you can scan images 
directly from the scanner to a PC. Using Microsoft Clip Organizer, you can scan, import, and store images 
from the printer. You can also scan directly from the printer to a computer using most TWAIN-compliant 
scanning applications. 

7 Scanning 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English


Scanning 

102 Xerox® WorkCentre® 4265 Multifunction Printer 
User Guide 

Basic Scanning 

The Scanning feature provides several methods for scanning and storing an original document. The 
scanning procedure using your printer differs from that of desktop scanners. The printer is connected 
typically to a network rather than a single computer, so you select a destination for the scanned image 
at the printer. For details, see Adjusting Scanning Settings on page 104. 

The printer supports the following scanning functions: 
• Scan documents and store images on the printer hard drive.
• Scan original documents to a document repository on a network server.
• Scan original documents to an email address.
• Scan original documents to your home directory.
• Scan original documents to a USB Flash drive.
• Import scanned images into applications using TWAIN and WIA.

Notes:

• The printer must be connected to a network to retrieve a scan file remotely.
• Print, copy, and fax jobs can print while you are scanning original documents or downloading

files from the printer hard drive.
• For details, see the Help in CentreWare Internet Services.

To scan an image: 
1. Load your original documents:

− Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

− Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

2. At the printer control panel, press Clear All, then press Services Home.
3. Touch Workflow Scanning.
4. Select a template from the list.
5. To change the scan setting, touch an option.
6. For more options, touch the More Features tab.
7. Press the green Start button.
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Document Glass 

• Lift the document feeder cover and place the
first page face down in the upper left corner
of the document glass.

• Align the originals to the matching paper size
printed on the edge of the glass.

• The document glass accommodates original
sizes up to 216 x 356 mm (8.5 x 14 in.).

• The document glass automatically detects
Legal or Letter/A4 and smaller paper sizes.

Document Feeder 

• Insert originals face up, with page one on top.
• Adjust the paper guides so they fit against the

originals.

• The document feeder accepts paper
weights from 50–105 g/m² (12.5–28 lb.)
for 2-sided pages.

• The document feeder accepts paper sizes from
145 x 145 mm (5.7 x 5.7 in.) through 216 x
356 mm (8.5 x 14 in.) for 1-sided pages, and
176 x 250 (6.93 x 9.84 in.) through 216 x
356 mm (8.5 x 14 in.) for 2-sided pages.

• The maximum feeder capacity is
approximately 100 sheets of 75 g/m² paper.

• The document feeder automatically detects
Legal or Letter/A4 size paper.

Document Feeder Guidelines 

When loading originals into the duplex automatic document feeder, follow these guidelines: 
• Insert originals face up with the top of the page entering the feeder first.
• Only place loose sheets of paper in the duplex automatic document feeder.
• Adjust the paper guides so that they fit against the originals.
• Only Insert paper in the duplex automatic document feeder when ink on the paper is dry.
• Do not load originals above the MAX fill line.
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Adjusting Scanning Settings 

This section includes: 
• Setting the Output Color ................................................................................................................................................. 104 
• Setting the Scan Resolution .......................................................................................................................................... 104 
• Selecting 2-Sided Scanning ........................................................................................................................................... 105 
• Setting the File Format .................................................................................................................................................... 105 
• Lightening or Darkening the Image .......................................................................................................................... 105 
• Automatically Suppressing Background Variation .............................................................................................. 105 
• Specifying the Original Size ........................................................................................................................................... 106 
• Erasing Edges ....................................................................................................................................................................... 106 
• Building a Scan Job ........................................................................................................................................................... 107 
 

Setting the Output Color 

If the original image contains color, you can scan the image in color or in black and white. Selecting 
black and white significantly reduces the file size of the scanned images. 

To set the output color: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Scan To, then select an option. 
3. Touch the More Features tab. 
4. Touch Output Color. 
5. Select a color mode. 
6. Touch OK. 
 

Setting the Scan Resolution 

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both 
the size and image quality of the scanned image file. Higher scan resolution produces better image 
quality and a larger file size. 

To set the scan resolution: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Scan To, then select an option. 
3. Touch More Features > Resolution. 
4. Select an option. 
5. Touch OK. 
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Selecting 2-Sided Scanning 

2-Sided Scanning scans both sides of the original image. 

To set 2-sided scanning: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Scan To, then select an option. 
3. Touch 2-Sided Scanning. 
4. Touch 2-Sided. 
5. To rotate the image on side 2 by 180 degrees, touch 2-Sided, then touch Rotate Side 2. 
6. Touch OK. 
 

Setting the File Format 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Scan To, then select an option. 
3. Touch File. 
4. Type a file extension, or select one from the menu. 
5. Touch OK. 
 

Lightening or Darkening the Image 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Scan To, then select an option. 
3. Touch More Features > Lighten/Darken. 
4. To lighten or darken the image, move the slider up or down. 
5. Touch OK. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To select Auto Suppression: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Scan To, then select an option. 
3. Touch More Features > Background Suppression. 
4. Touch Auto Suppression. 
5. Touch OK. 
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Specifying the Original Size 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Scan To, then select an option. 
3. Touch Original Size, then select an option. 
4. Touch OK. 
 

Erasing Edges 

To use Edge Erase: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Scan To, then select an option. 
3. Touch More Features > Scan to Edge. 
4. To change the Edge Erase settings, select an option. 
5. Touch OK. 
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Building a Scan Job 

Use this feature to combine an assorted group of originals for assembly into a single scan job. 

When you build a scan job, each individual segment is scanned as a single job. At any time, you can 
touch Delete All Segments to modify the job. 

To build a scan job: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Workflow Scanning, then touch an option. 
3. Touch More Features > Build Job. 
4. Touch On. 
5. Touch Options. 

a. Select or clear the Display Summary window between segments check box. 
b. Select or clear the Turn Build Job Off after Job is Submitted check box. 

6. Touch OK. 
7. Program and scan the first segment: 

a. Load the originals for the first segment. 
b. Press the green Start button on the control panel. 

8. If a password is required, contact the system administrator. 
9. Program and scan additional segments: 

a. Load the originals for the next segment. 
b. When the Build Job screen appears, touch Program Next Segment. 
c. Press the green Start button to scan the originals for that segment. 

10. Repeat the previous step for each remaining segment. 
11. At any time, you can touch Delete All Segments to modify the job. 
12. When all of the segments have been programmed and scanned, touch Submit the Job. 

If necessary, touch Delete > Delete Job to cancel the job. 
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Selecting Filing Options 

Filing Options provide additional settings for naming images, selecting image formats, and selecting 
behavior when a file name exists. 

Document Management and Add File Destinations can be modified only after scanning to network file 
repositories or scanning to home are set up. For details, see the System Administrator Guide at 
www.xerox.com/office/WC4265docs. 

To select filing options: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Workflow Scanning > File. 

To select a file format: 
1. Type a file extension, or select one from the menu. 
2. Touch OK. 

To select the action to take if a file already exists: 
1. Touch the More Features tab. 
2. Touch If File Already Exists. 
3. Select an option. 
4. Touch OK. 

To define additional network locations as destinations for scanned documents: 
1. Touch the More Features tab. 
2. Touch Add File Destinations. 
3. Select an option. 
4. Touch OK. 
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Sending a Scanned Image to a Destination 

Before scanning to a destination, configure the destination folders on the server or share the folder on a 
personal computer. In addition, you must have at least one Scan To Destination in the address book. If 
Scan To Destination properties are not properly configured, the Scan To icon appears grayed out on the 
touch screen. 

To scan an image and send it to a destination: 
1. Load the original on the document glass or in the document feeder. 
2. At the printer control panel, press Clear All, then press Services Home. 
3. Touch Scan To > Scan Contacts. 
4. Select an option. 
5. Select the desired name from the list, then touch OK. 
6. Change scan settings as needed. 
7. Press the green Start button. 

For details, see Adjusting Scanning Settings on page 104. 
 



Scanning 

 

110 Xerox® WorkCentre® 4265 Multifunction Printer 
 User Guide 
 

Scanning to a Shared Folder on a Network 
Computer 

This section includes: 
• Sharing a Folder on a Windows Computer ............................................................................................................. 110 
• Sharing a Folder Using Macintosh OS X Version 10.7 and Later ................................................................... 111 
• Scanning to a Folder on a Network Computer ...................................................................................................... 111 

Before using the printer as a scanner on a network, you must: 
1. Create a shared folder on your computer hard drive. 
2. Create an address using CentreWare Internet Services or the Address Book Editor pointing the 

scanner to the computer. 
 

Note: For more information, see Connecting the Printer on page 38. 
 
 

Sharing a Folder on a Windows Computer 

Before you begin: 
• Verify that your computer security software allows for file sharing. 
• Verify that File and Printer Sharing For Microsoft Networks is enabled for each of your connections. 

Note: For assistance, contact your system administrator. 

To turn on sharing: 
1. Open Windows Explorer. 
2. Right-click the folder you want to share, then select Properties. 
3. Click the Sharing tab, then click Advanced Sharing. 
4. Select Share this folder. 
5. Click Permissions. 
6. Select the Everyone group, and verify that all permissions are enabled. 
7. Click OK. 

Note: Remember the Share name for later use. 

8. Click OK again. 
9. Click Close. 
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Sharing a Folder Using Macintosh OS X Version 10.7 and Later 
1. From the Apple menu, select System Preferences. 
2. Select Sharing. 
3. From the Service menu, select File Sharing. 
4. Under Shared Folders, click the plus icon (+). 
5. Browse to the folder that you want to share on the network, then click Add. 
6. To modify access rights for your folder, select it. The groups activate. 
7. From the Users list, click Everyone, then use the arrows to select Read & Write. 
8. Click Options. 
9. To share the folder with Windows computers, select Share files and folders using SMB. 
10. To share the folder with specific users, next to the user name, select On. 
11. Click Done. 
12. Close the System Preferences window. 

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder 
and subfolders. 

 

Scanning to a Folder on a Network Computer 
1. Load the original on the document glass or in the duplex automatic document feeder. 
2. Press the Services Home button, then touch Workflow Scanning. 
3. Select a template from the list. 
4. Change scan settings as needed. For details, see Adjusting Scanning Settings on page 104. 
5. To begin the scan, press Start. 
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Scanning to Your Home Directory 

The Scan to Home feature allows you to scan an image to your home directory. 

Note: To use the Scan to Home function, you must log in with a valid user name and passcode. 

To scan an image to your home directory: 
1. Load the original on the document glass or in the document feeder. 
2. At the printer control panel, press Clear All, then press Services Home. 
3. Touch Workflow Scanning. 
4. Select the template that the system administrator created. 
5. Change scan settings as needed. 
6. Press the green Start button. 
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Scanning to an Email Address 

When using this feature, the images you scan are sent as email attachments. 

Before scanning to email, configure the email SMTP and From Field properties. You must have at least 
one email address in the address book. If email properties are not properly configured, the Email icon 
appears grayed out on the touch screen. 

To scan an image and send it to an email address: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Email. 
3. To enter an email address, do the following. 

a. Touch Enter Recipient. 
b. Touch the down arrow, then from the menu, select To: or Cc: or Bcc:. 
c. Type the email address. 
d. Touch OK. 

4. To enter an email address from the network address book, do the following. 
a. Touch Device Address Book. 
b. Select the desired name from the list, then touch OK. 

5. To add a subject line, do the following. 
a. Touch Subject, then type the desired text. 
b. To modify the default subject, touch X to delete it, or type over the existing text. 
c. Touch OK. 

6. To change any of the scan settings, use options on the More Features tab. 
7. Press the green Start button. 
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Scanning to a USB Flash Drive 

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function 
produces scans in .jpg, .pdf, and .tiff file formats. 

To scan to a USB Flash drive: 
1. Load the original on the document glass or in the duplex automatic document feeder. 
2. Insert your USB Flash drive into the USB port on the side of the printer. 
3. Touch USB > Scan to USB. 
4. Change scan settings as needed. For details, see Adjusting Scanning Settings on page 104. 
5. To begin the scan, press Start. 
 

 WARNING: Do not remove the USB Flash drive until prompted. If you remove the Flash drive before 
the transfer is complete, the file can become unusable and other files on the drive can be damaged. 
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Scanning to a Computer 

If the system administrator enables Remote Start in CentreWare Internet Services, you can scan images 
directly from the scanner to a PC. Using Microsoft Clip Organizer, you can scan, import, and store images 
from the printer. You can also scan directly from the printer to a computer using most TWAIN-compliant 
scanning applications. 
 

Scanning to a Computer 
1. At the printer, load the original on the document glass or in the automatic document feeder. 
2. At your computer, click Start > Programs > Microsoft Office > Microsoft Office Tools > Microsoft 

Clip Organizer. 
3. Click File > Add Clips to Organizer > From Scanner or Camera. 
4. Click Device > Xerox TWAIN Driver. 
5. Click Custom Insert. 
6. If multiple scanners are installed on your computer, click Select Scan Device, select the scanner, 

then click Select. 
7. To select a size for the scanned image, click Scan Size and select an option. 
8. To select the sides to scan from the original, click Side to Scan and select an option: 

− 1-Sided Scan: This setting scans only one side of the original document or image and produces 
1-sided output files. 

− 2-Sided Scan: This setting scans both sides of the original document or image. 
− 2-Sided Scan, Short Edge scans both sides of the original image on the short edge. 

9. To select the resolution to scan the image, click Resolution, then select an option. 
10. To adjust the scan color, click Image Color and select an option: 

− Auto detects the color content in the original image. If the original image is color, the printer 
scans in full color. If the original is a black and white document, the printer scans in black and 
white only. 

− Color: Scans in full color. 
− Grayscale: Detects and scans various shades of gray. 
− Black and White: This setting scans in black and white only. 

11. To scan the image, click Scan. 
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The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC4265docs. 
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Basic Faxing 

To send a fax: 
1. Load your original documents:

− Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

− Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

2. Press the Services Home button, then touch Fax.
3. Address the fax using one or more of the available options:

− Enter Recipient: This option allows you to enter a fax number manually.
− Manual Dial Mode: This option allows you to insert characters, such as Dial Pause, in a fax

number. 
− Device Address Book: This option allows you to access the printer address book.

4. Adjust additional fax options as needed. For details, see Selecting Fax Options on page 120.
5. Press the green Start button. The printer scans the pages and transmits the document when all

pages have been scanned.

Document Glass 

• Lift the document feeder cover and place the
first page face down in the upper left corner
of the document glass.

• Align the originals to the matching paper size
printed on the edge of the glass.

• The document glass accommodates original
sizes up to 216 x 356 mm (8.5 x 14 in.).

• The document glass automatically detects
Legal or Letter/A4 and smaller paper sizes.
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Document Feeder 

• Insert originals face up, with page one on top.
• Adjust the paper guides so they fit against the

originals.

• The document feeder accepts paper
weights from 50–105 g/m² (12.5–28 lb.)
for 2-sided pages.

• The document feeder accepts paper sizes from
145 x 145 mm (5.7 x 5.7 in.) through 216 x
356 mm (8.5 x 14 in.) for 1-sided pages, and
176 x 250 (6.93 x 9.84 in.) through 216 x
356 mm (8.5 x 14 in.) for 2-sided pages.

• The maximum feeder capacity is
approximately 100 sheets of 75 g/m² paper.

• The document feeder automatically detects
Legal or Letter/A4 size paper.

Duplex Automatic Document Feeder Guidelines 

When loading originals into the duplex automatic document feeder, follow these guidelines: 
• Insert originals face up with the top of the page entering the feeder first.
• Only place loose sheets of paper in the duplex automatic document feeder.
• Adjust the paper guides so that they fit against the originals.
• Only Insert paper in the duplex automatic document feeder when ink on the paper is dry.
• Do not load originals above the MAX fill line.



Faxing 

 

120 Xerox® WorkCentre® 4265 Multifunction Printer 
 User Guide 
 

Selecting Fax Options 

This section includes: 
• Specifying the Size of the Original ............................................................................................................................. 120 
• Sending a Delayed Fax .................................................................................................................................................... 120 
• Automatically Suppressing Background Variation .............................................................................................. 121 
• Sending Header Text ........................................................................................................................................................ 121 
• To Lighten or Darken an Image .................................................................................................................................. 121 
• Building a Fax Job .............................................................................................................................................................. 122 
 

Specifying the Size of the Original 

To ensure that you are scanning the correct area of the documents, specify the original size. 

To specify the original size: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax, then touch an option. 
3. Touch More Features > Original Size. 
4. Touch an option, then touch OK. 
 

Sending a Delayed Fax 

You can scan and save a fax on the printer, then send it at a later time. 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax, then touch an option. 
3. Touch More Features > Delay Send. 
4. Touch the Hour field, then touch the arrows to set a number. 
5. Touch the Minute field, then touch the arrows to set a number. 
6. If your printer is set to display the 12-hour clock, touch AM or PM. 
7. Touch OK. 
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Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To select Auto Suppression: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax, then touch an option. 
3. Touch More Features > Background Suppression. 
4. Touch Auto Suppression. 
5. Touch OK. 
 

Sending Header Text 

The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC4265docs. 

To include the fax header text: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax, then touch an option. 
3. Touch More Features > Send Header Text. 
4. Touch On, then touch OK. 
 

To Lighten or Darken an Image 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax, then touch an option. 
3. Touch More Features > Lighten/Darken. 
4. Touch OK. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
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Building a Fax Job 

Use this feature to fax an assorted group of originals, each with different settings. Each segment is 
programmed and scanned, and the images are stored temporarily in the printer. Once all segments have 
been stored, the individual segments are faxed as a single job. 

To build a fax job: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax, then touch an option. 
3. Touch More Features > Build Job. 
4. Touch On. 
5. Touch Options. 

− Select or clear the Display Summary window between segments check box. 
− Select or clear the Turn Build Job Off after Job is Submitted check box. 

6. Program and scan the first segment: 
a. Load the originals for the first segment. 
b. Select the required settings, such as layout adjustments, image quality, and options. 
c. Press the green Start button. 

7. Program and scan additional segments: 
a. Load the originals for the next segment. 
b. When the Build Job screen appears, touch Program Next Segment. 
c. Using the appropriate tabs, select the required settings. 
d. Press the green Start button to scan the originals for that segment. 

8. Repeat the previous step for each remaining segment. 
9. When all of the segments have been programmed and scanned, touch Submit the Job. 
10. On the Job Progress screen, touch Job Details to view a summary of the job. 
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Storing a Fax in a Local Mailbox 

The system administrator must create a mailbox before you can use this feature. For details, see the 
System Administrator Guide at www.xerox.com/office/WC4265docs. 

To store a fax in a local mailbox: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax > Mailboxes. 
3. Touch Store To Mailbox > Local Mailbox. 
4. Touch an option, then touch OK. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
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Printing Local Mailbox Documents 

To use this feature, you must have documents stored in a mailbox. For details, see Storing a Fax in a 
Local Mailbox on page 123. 

To print local mailbox documents: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax > Mailboxes. 
3. Touch Print From Mailbox. 
4. Touch an option. 
5. Touch Print. 
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Sending a Fax to a Remote Mailbox 

1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax > Mailboxes. 
3. Touch Store To Mailbox > Remote Mailbox. 
4. Touch an option, then touch OK. 
 



Faxing 

 

126 Xerox® WorkCentre® 4265 Multifunction Printer 
 User Guide 
 

Storing a Fax for Local or Remote Polling 

Turn on Secure or Non-Secure Local Polling to make fax documents stored on one printer available for 
remote polling by other printers. When Secure Local Polling is on, you create a list of fax numbers that 
are allowed to access the stored faxes on the printer. 

To store a fax: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax > Polling. 
3. Touch Store Locally for Remote Polling. 
4. Touch an option. 
5. Touch Save. 
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Polling a Remote Fax 

If remote polling is turned on, you can retrieve documents that were stored using local polling on 
another fax machine. 

Note: If Local Polling is turned on, Remote Polling is not available. To turn off Local Polling, touch 
Local Polling > Off > Save. 

To poll a remote fax: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax > Polling. 
3. Touch Retrieve/Print Remote Files. 
4. Type the fax number. 
5. Touch Print. 
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Printing or Deleting Stored Faxes 

1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax > Polling. 
3. Touch Local File Management, then select an option. 
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Using the Address Book 

This section includes: 
• Adding an Individual Entry to the Device Address Book................................................................................... 129 
• Editing an Individual Address Book Entry ............................................................................................................... 129 
 

Adding an Individual Entry to the Device Address Book 

The Device Address Book stores a maximum of 2000 contacts. If the Add button is unavailable, the 
address book has reached its limit. 

Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch 
Screen for All Users. 

To add a recipient to the Device Address Book: 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax > Device Address Book. 
3. Touch Create New Contact. 
4. To enter a name, fax number, or optional email address, touch each field, then enter the details. 
5. To add a company name, touch the i icon. 
6. To mark any entered contact information as a favorite, touch the star icon. 
7. Touch OK. 
 

Editing an Individual Address Book Entry 
1. At the printer control panel, press Clear All, then press Services Home. 
2. Touch Fax > Device Address Book. 
3. Touch the address book entry. 
4. Touch OK. 
5. Touch the contact name. 
6. To edit the fields, touch Details. 
7. To delete the contact, touch Remove. 
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This chapter includes: 
• Cleaning the Printer .......................................................................................................................................................... 132 
• Ordering Supplies ............................................................................................................................................................... 136 
• Managing the Printer ....................................................................................................................................................... 140 
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Cleaning the Printer 

This section includes: 
• General Precautions .......................................................................................................................................................... 132 
• Cleaning the Exterior ........................................................................................................................................................ 133 
• Cleaning the Scanner ....................................................................................................................................................... 133 
• Cleaning the Interior ........................................................................................................................................................ 135 
 

General Precautions 
 

 CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting. 
Do not touch or scratch the surface of the drum. 

  

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol 
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as 
directed in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays 
contain explosive mixtures and are not suitable for use in electrical applications. Use of pressurized 
spray cleaners increases the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

• Do not place anything on top of the printer. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the drum cartridge. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Exterior 

Clean the exterior of the printer once a month. 
• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth. 
• After cleaning, wipe with a dry, soft cloth. 
• For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain 

off. 
 

 CAUTION: Do not spray detergent directly on the printer. Liquid detergent could enter the printer 
through a gap and cause problems. Never use cleaning agents other than water or mild detergent. 

 
 

Cleaning the Scanner 

Clean the scanner about once a month, when anything is spilled on it, or when debris or dust collect on 
any of the surfaces. Keep the feed rollers clean to ensure the best possible copies and scans. 
 

Cleaning the Document Cover 
1. Slightly dampen a soft, lint-free cloth with water. 
2. Remove any paper from the document feeder. 

 
3. Open the document cover. 

 



Maintenance 

 

134 Xerox® WorkCentre® 4265 Multifunction Printer 
 User Guide 
 

4. Wipe the surface of the document glass until it is clean and dry. 

Note: For best results, to remove marks and streaks, use a standard glass cleaner. 

 
5. Wipe the white underside of the document cover until it is clean and dry. 

 
6. Close the document cover. 
 

Cleaning the Feed Rollers, Separation Pad, and Scanner Components 

Debris and toner stains on the document feeder feed rollers, separation pads, and scanner components 
can cause stains or unwanted marks on printed documents. To remove stains, use a soft lint-free cloth 
dampened with a neutral detergent or water. 

You can view a video on the control panel that shows how to clean the feed rollers, separation pads, and 
scanner components. 

To view the video: 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Self Help. 
3. For Videos, select Clean Feeder to Improve Quality. 
4. To view the video, touch Play Video. 
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Cleaning the Interior 

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer 
regularly. Clean the printer interior whenever you replace the drum cartridge. 

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing 
the printer covers and doors. 
• Remove any remaining pieces of paper or debris. For details, see Clearing Paper Jams on page 152. 
• Remove any dust or stains with a dry, clean cloth. 
 

 WARNING: To avoid injury, never touch a labeled area on or near the heat roller in the fuser. If a 
sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the 
printer immediately and wait 30 minutes for the fuser to cool. After the printer cools, try to remove 
the jammed paper. If the error persists, contact your Xerox representative. 
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Ordering Supplies 

This section includes: 

 Consumables ........................................................................................................................................................................ 136

 Routine Maintenance Items ......................................................................................................................................... 136

 When to Order Supplies ................................................................................................................................................... 137

 Viewing Printer Supply Status ...................................................................................................................................... 137

 Toner Cartridges ................................................................................................................................................................. 138

 Recycling Supplies .............................................................................................................................................................. 139

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. The consumable 
supply for this printer is the genuine Xerox® Black Toner Cartridge. 

Notes: 

 Each consumable includes installation instructions.

 To ensure print quality, the toner cartridge has been designed to cease functioning at a
predetermined point.

CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer 
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by 
Xerox for specific use with this printer. 

Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 

Note: Each routine maintenance item includes installation instructions. 

Routine maintenance items for this printer include the following: 

 Smart Kit Drum Cartridge

 Fuser Maintenance Kit

 Bias Transfer Roll (BTR) Maintenance Kit

 Feed Roll Maintenance Kit

 Staple Cartridge

Note: Not all options listed are supported on all printers. Some options apply only to specific printer 
models or configurations.
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When to Order Supplies 

A warning appears on the control panel when the Toner Cartridge or the Smart Kit Drum Cartridge are 
near their replacement time. Verify that you have replacements on hand. It is important to order these 
items when the messages first appear to avoid interruptions to your printing. An error message appears 
on the control panel when the Toner Cartridge or the Smart Kit Drum Cartridge must be replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/WC4265supplies. 
 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 

 
 

Viewing Printer Supply Status 

You can check the status and percentage of life remaining for your printer supplies at any time using 
CentreWare Internet Services or the control panel. 

To view printer supply status using CentreWare Internet Services: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. Select the Status tab. 
3. For Status, click Consumables. 

To view printer supply status using the control panel: 

At the control panel, press Machine Status, then touch the Supplies tab. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=order&Language=English
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Toner Cartridges 

This section includes: 
• General Precautions .......................................................................................................................................................... 138 
• Replacing a Toner Cartridge.......................................................................................................................................... 139 
 

General Precautions 
 

 WARNINGS: 

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid 
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust. 

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the 
child spit out the toner, and rinse out their mouth with water. Consult a physician immediately. 

• Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric 
sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of 
toner, contact your local Xerox representative. 

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch 
fire and cause burn injuries or an explosion. 

 

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

 

• Do not open covers and doors during printing. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the drum cartridge. 
• Do not place anything on top of the printer. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Replacing a Toner Cartridge 

When a toner cartridge approaches the end of its usable life span, the control panel displays a toner low 
message. When a toner cartridge is empty, the printer stops and displays a message on the control 
panel. 

Note: Each toner cartridge includes installation instructions. 
 

Printer Status Message Cause and Solution 

Low Toner Status. Ensure that a new Toner Cartridge 
is available. 

The toner cartridge is low. Order a new toner cartridge. 

Replace Toner Cartridge The toner cartridge is empty. Open the side door and then 
the front door, then replace the toner cartridge. 

 

Recycling Supplies 

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=recyclesupplies&Language=English
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Managing the Printer 

This section includes: 
• Moving the Printer ............................................................................................................................................................. 140 
• Billing and Usage Information ..................................................................................................................................... 141 
 

Moving the Printer 
 

 WARNINGS: 

• To prevent electric shock, never touch the power plug with wet hands. When removing the power 
cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which can 
lead to fire or electric shock. 

• When moving the printer, do not tilt it more than 10 degrees to the front, back, left, or right. 
Tilting the printer more than 10 degrees can cause toner spillage. 

Follow these instructions when moving the printer: 
1. Turn off the printer and disconnect the power cord and other cables from the back of the printer. 

For details, see Turning the Printer On and Off on page 40. 
2. Remove any paper or other media from the output tray. 
3. For ease of transport, remove the finisher. 
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4. When moving the printer from one location to another, use caution to ensure that the printer does 
not topple. 

5. When lifting the printer, grasp the areas as shown. 

 
Notes: 

• To prevent dropping or tipping the printer, hold the printer between two people, with each 
person using one hand underneath to hold the printer and the other hand on top to stabilize it. 

• Repack the printer and its options using the original packing material and boxes or a Xerox 
Repackaging Kit. For a repacking kit and instructions, go to 
www.xerox.com/office/WC4265support. 

 

 CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered 
by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, 
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by 
improper moving. 
 

After moving the printer: 
1. Reinstall any parts you removed. 
2. Reconnect the printer to the cables and power cord. 
3. Plug in and turn on the printer. 
 

Billing and Usage Information 

Billing and printer usage information appears on the Billing Meters information screen. The impression 
counts shown are used for billing. 

To view Billing and Usage information: 
1. At the printer control panel, press the Machine Status button. 
2. To view basic impression counts, touch the Billing Information tab: 
3. To view detailed usage information, touch Usage Counters. 
4. To refresh the usage information, touch Update Counters. 

Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed 
on two sides counts as two impressions. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=tech&Language=English
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This chapter includes: 
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• Paper Jams ............................................................................................................................................................................ 150 
• Print-Quality Problems ..................................................................................................................................................... 166 
• Copy and Scan Problems ................................................................................................................................................ 170 
• Fax Problems ........................................................................................................................................................................ 171 
• Getting Help ......................................................................................................................................................................... 173 
 

 10 Troubleshooting 



Troubleshooting 

 

144 Xerox® WorkCentre® 4265 Multifunction Printer 
 User Guide 
 

General Troubleshooting 

This section includes: 
• General Precautions .......................................................................................................................................................... 144 
• Restarting the Printer ....................................................................................................................................................... 145 
• Printer Fails to Power On ................................................................................................................................................. 146 
• Printer Resets or Turns Off Frequently ...................................................................................................................... 146 
• Document Prints from Wrong Tray ............................................................................................................................ 146 
• Automatic 2-Sided Printing Problems ....................................................................................................................... 147 
• Paper Tray Fails to Close ................................................................................................................................................. 147 
• Printing Takes Too Long.................................................................................................................................................. 147 
• Printer Fails to Print ........................................................................................................................................................... 148 
• Printer is Making Unusual Noises ................................................................................................................................ 148 
• Condensation Has Formed Inside the Printer ........................................................................................................ 149 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 
 

General Precautions 

To maintain and operate your printer safely, follow each of the precautions mentioned in this section. 
 

Avoiding Damage to the Printer 
• Do not place anything on top of the printer. 
• Do not leave the covers and doors open for any length of time. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
 

Avoiding Hot Printer Parts 
 

 WARNINGS: 

• Internal parts of the printer can be hot. Use caution when doors and covers are open.  
• To avoid personal injury or printer damage, wait 30 minutes for the fuser to cool. 
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Caution When Cleaning 

 CAUTIONS: 

• When cleaning your printer, do not use organic or strong chemical solvents or aerosol cleaners. 
• Do not pour fluids directly into any area of the printer. 
• Use supplies and cleaning materials only as directed in the Maintenance section of this manual. 
• Do not spray detergent directly on the printer. Liquid detergent could enter the printer through a 

gap and cause problems. Never use cleaning agents other than water or mild detergent. 
 

 WARNING: Keep all cleaning materials out of the reach of children. 
 
 

Maintenance Restrictions 
 

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

 
 

Restarting the Printer 

To restart the printer: 
1. Press Power Saver. 
2. Touch Power Down. 
3. To restart the printer, turn on the power switch. 

Note: If restarting the printer does not resolve the problem, see the table in this chapter that best 
describes the problem. 
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Printer Fails to Power On 
 

Probable Causes Solutions 

The power switch is not turned on. Turn on the power switch. For details, see Turning the Printer On 
and Off on page 40. 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer power switch, and plug the power cord securely 
into the outlet. 

Something is wrong with the outlet 
connected to the printer. 

• Plug another electrical appliance into the outlet and see if it 
operates properly. 

• Try a different outlet. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source within the specifications for the printer. 

 CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 

See also: 
• Turning the Printer On and Off on page 40 
• Electrical Specifications on page 185 
 

Printer Resets or Turns Off Frequently 
 

Probable Causes Solutions 

The power cord is not plugged into the outlet 
correctly. 

Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. 

A system error occurred. Turn off the printer, then turn it on again. Print the Error History 
report from the Information Pages menu. If the error persists, 
contact your Xerox representative. 

The printer is connected to an uninterruptible 
power supply. 

Turn off the printer, then connect the power cord to a suitable 
outlet. 

The printer is connected to a power strip 
shared with other high-power devices. 

Plug the printer directly into the outlet or into a power strip that is 
not shared with other high-power devices. 

 
 

Document Prints from Wrong Tray 
 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver. 
2. Go to the page setup or printer settings of the application from 

which you are printing. 
3. Set the paper source to match the tray selected in the print 

driver or set the paper source to Automatically Select. 
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Automatic 2-Sided Printing Problems 
 

Probable Causes Solutions 

Unsupported or incorrect paper. Ensure that you are using a supported paper size and weight for 
2-sided printing. Envelopes and labels cannot be used for 2-sided 
printing. For details, see Supported Standard Types and Weights for 
Automatic 2-Sided Printing on page 54 and Supported Standard 
Paper Sizes for Automatic 2-Sided Printing on page 54. 

Incorrect setting. In the print driver Properties, select 2-Sided Print on the 
Paper/Output tab. 

 
 

Paper Tray Fails to Close 
 

Probable Cause Solution 

The paper tray does not close fully. Some debris or an object is blocking the tray. 

 
 

Printing Takes Too Long 
  

Probable Causes Solutions 

The printer is set to a slower printing mode. 
For example, the printer could be set to print 
on Heavyweight paper. 

It takes more time to print on certain types of special paper. Ensure 
that the paper type is set properly in the driver and at the printer 
control panel. For details, see Print Speed on page 186. 

The printer is in Power Saver mode. It takes time for printing to start when the printer is coming out of 
Power Saver mode. 

The way the printer was installed on the 
network could be an issue. 

Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. To test the speed of the printer, 
print some information pages such as the Office Demo Page. If the 
page prints at the rated speed of the printer, you could have a 
network or printer installation issue. For additional help, contact the 
system administrator. 

The job is complex. Wait. No action needed. 

The print-quality mode in the driver is set to 
Enhanced. 

Change the print-quality mode in the print driver to Standard. 
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Printer Fails to Print 
 

Probable Causes Solutions 

The printer has an error. • To clear the error, follow the onscreen prompts. 
• If the error persists, contact your Xerox representative. 

The printer is out of paper. Load paper into the tray. 

A toner cartridge is empty. Replace the empty toner cartridge. 

The front door is open. • Ensure that the toner cartridge and Smart Kit drum cartridge are 
installed and fully seated. 

• Ensure that the front and side doors are closed. 

Note: For the doors to lock properly, close the front door 
first, then close the side door. 

• Turn off the printer, then turn it on again. If the error persists, 
contact your Xerox representative. 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. For 
details, see Turning the Printer On and Off on page 40. If the error 
persists, contact your Xerox representative. 

The printer is busy. • A previous print job could be the problem. On your computer, 
you can use the printer properties to delete all print jobs in the 
print queue. 

• Load the paper in the tray. 
• At the printer control panel, press the Job Status button. If the 

print job does not appear check the Ethernet connection 
between the printer and the computer. 

• At the printer control panel, press the Job Status button. If the 
print job does not appear, check the USB connection between 
the printer and the computer. Turn off the printer, then turn it on 
again. 

The printer cable is disconnected. • At the printer control panel, press the Job Status button. If the 
print job does not appear check the Ethernet connection 
between the printer and the computer. 

• At the printer control panel, press the Job Status button. If the 
print job does not appear, check the USB connection between 
the printer and the computer. Turn off the printer, then turn it on 
again. 

 
 

Printer is Making Unusual Noises 
 

Probable Causes Solutions 

There is an obstruction or debris inside the 
printer. 

Turn off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox representative. 
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Condensation Has Formed Inside the Printer 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is 
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that 
is heated quickly. 
 

Probable Causes Solutions 

The printer has been sitting in a cold room. • Allow the printer to acclimate for several hours before operation. 
• Allow the printer to operate for several hours at room 

temperature. 

The relative humidity of the room is too high. • Reduce the humidity in the room. 
• Move the printer to a location where the temperature and 

relative humidity are within the operating specifications. 
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Paper Jams 

This section includes: 
• Minimizing Paper Jams .................................................................................................................................................... 150 
• Locating Paper Jams ......................................................................................................................................................... 151 
• Clearing Paper Jams ......................................................................................................................................................... 152 
• Troubleshooting Paper Jams ......................................................................................................................................... 164 
 

Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver. 
• Using damaged paper. 
• Using unsupported paper. 
• Loading paper incorrectly. 
• Overfilling the tray. 
• Adjusting the paper guides improperly. 

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. For details, see Supported Paper on page 50. 
• Follow proper paper handling and loading techniques. 
• Always use clean, undamaged paper. 
• Avoid paper that is curled, torn, moist, creased, or folded. 
• To separate the sheets before loading into the tray, fan the paper. 
• Observe the paper tray fill line; never overfill the tray. 
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 

can cause poor print quality, misfeeds, skewed prints, and printer damage. 
• After loading the trays, select the correct paper type and size on the control panel. 
• When printing, select the correct type and size in the print driver. 
• Store paper in a dry location. 
• Use only Xerox paper and transparencies designed for the printer. 
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Avoid the following: 
• Polyester coated paper that is specially designed for inkjet printers. 
• Paper that is folded, wrinkled, or excessively curled. 
• Loading more than one type, size, or weight of paper in a tray at the same time. 
• Overfilling the trays. 
• Allowing the output tray to overfill. 

For a detailed list of supported paper, go to www.xerox.com/paper. 
 

Locating Paper Jams 
 

 WARNING: To avoid injury, never touch a labeled area on or near the heat roller in the fuser. If a 
sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the 
printer immediately and wait 30 minutes for the fuser to cool. After the printer cools, try to remove 
the jammed paper. If the error persists, contact your Xerox representative. 
 

The following illustration shows where paper jams can occur along the paper path: 

 
 

1. Feeder Trays 
2. Output Tray/Finisher 
3. Document Feeder Top Cover 
4. Document Feeder Paper Path 

5. Fuser Area 
6. Duplex Area 
7. Bypass Tray 

 

 

http://www.xerox.com/printer-supplies/recommended-paper/enus.html
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Clearing Paper Jams 

This section includes: 
• Clearing Paper Jams from Tray 1 ................................................................................................................................ 152 
• Clearing Paper Jams from Trays 2-4 .......................................................................................................................... 154 
• Clearing Paper Jams from the 2100-Sheet High-Capacity Feeder ............................................................... 155 
• Clearing Jams in the Optional Finisher ..................................................................................................................... 157 
• Clearing Paper Jams from the Document Feeder ................................................................................................ 158 
• Clearing Paper Jams from the Fuser Area ............................................................................................................... 161 
• Clearing Paper Jams from the Duplex Area ............................................................................................................ 162 
• Clearing Paper Jams at the Bypass Tray .................................................................................................................. 163 
 

Clearing Paper Jams from Tray 1 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
1. Remove Tray 1 from the printer. 

 
2. Remove any crumpled paper from the tray and any remaining paper jammed in the printer. 
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3. Insert tray 1 into the printer, then push it in all the way. 

 
4. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
5. Touch Confirm. 
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Clearing Paper Jams from Trays 2-4 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
1. Remove tray 2 from the printer. 

 
2. Remove any crumpled paper from the tray and any remaining paper jammed in the printer. 

 
3. Insert tray 2 into the printer, then push it all the way in. 
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4. If the control panel prompts you, open the outside and inside covers, then remove the jammed 
paper. 

          
5. Close the inside and outside covers. 
6. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
7. Touch Confirm. 
 

Clearing Paper Jams from the 2100-Sheet High-Capacity Feeder 
1. Before removing the paper tray from the printer, look at the jam message on the control panel. If 

another jam is shown, clear that jam first. 
2. Open the high-capacity feeder tray then remove any damaged paper. 
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3. If the control panel prompts you, open the outside and inside covers, then remove the jammed 
paper. 

Note: If the paper does not move easily, to remove it, reach behind the high-capacity feeder tray 
and grasp the paper, then pull gently. 

      
4. If the paper is torn, remove all torn pieces from the printer. 
5. Push the tray back into the printer completely, then close the inside and outside covers. 
6. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
7. Touch Confirm. 
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Clearing Jams in the Optional Finisher 
1. Open the finisher front door. 

 
2. To access the finisher, release lever 1c, then slide the finisher unit to the left. 
 

 CAUTION: To avoid dropping the finisher, do not slide the finisher too far to the left 
 

1a

 
3. Remove any jammed paper from inside the finisher area. 
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4. If the paper is torn, remove all torn pieces from the finisher. 
5. Close the finisher front door. 

 
6. To return the finisher to its original position, lift slightly and push to the right until the finisher clicks 

into place. 

 
 

Clearing Paper Jams from the Document Feeder 
1. Remove any paper from the document feeder. 
2. Open the document feeder top cover. 
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3. If paper is jammed in the exit of the document feeder, pull it out as illustrated. 

 
4. To access the document feeder to remove jammed paper, lift the document feeder cover. 

 
5. To open the document feeder inside cover, gently pull the green lever. 

 
6. Remove any paper or debris from the paper path. 
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7. Press the document feeder inside cover into its original position, then ensure that the lever is locked 
in place. 

Note: Ensure that the magnetic edge of the white plastic strip rests securely against the metal strip. 

 
8. Close the document feeder cover. 
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Clearing Paper Jams from the Fuser Area 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
1. To access jammed paper in the fuser area, open the right side door. 

 
2. Gently remove any paper from the fuser area. 
 

 WARNING: The area around the fuser can be hot. Use caution to avoid injury. 
 

 
3. Close the right side door. 
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Clearing Paper Jams from the Duplex Area 
1. To access paper jams in the duplex area, open the right side door. 

 
2. Gently remove any paper from the duplex area. 

 
3. Close the right side door. 
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Clearing Paper Jams at the Bypass Tray 
1. Remove any paper from the bypass tray. Where the tray connects to the printer, clear any paper 

that is jammed. 

 
2. If the paper is torn, check inside the printer for pieces of paper, then gently remove them. If you 

cannot remove the paper fragments easily, contact your Xerox representative. 
 

 WARNING: The area around the fuser can be hot. Use caution to avoid injury. 
 

3. When you reload the bypass tray, fan the paper and ensure that all four corners align neatly. 
4. If the control panel prompts you, verify the size and type on the screen. 
5. Touch Confirm. 
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Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .................................................................................................................................. 164 
• Paper Misfeeds .................................................................................................................................................................... 164 
• Label and Envelope Misfeeds ....................................................................................................................................... 165 
• Paper Jam Message Stays On ....................................................................................................................................... 165 
• Jams During Automatic 2-Sided Printing ................................................................................................................ 165 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry paper. 

Too much static electricity is present. • Try a new ream of paper. 
• Do not fan transparencies before loading in tray. 

Using unsupported paper. Use only Xerox approved paper. For details, see Supported Paper on 
page 50. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 
  
 

Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

• Remove the misfed paper and reposition it properly in the tray. 
• Adjust the paper guides in the tray to match the size of the 

paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted 
to the paper size. 

Adjust the paper guides in the tray to match the size of the paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still misfeeds, 
do not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness, or 
type. 

Use only Xerox approved paper. For details, see Supported Paper on 
page 50. 
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Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in the 
tray. 

• Load label sheets according to the instructions from the 
manufacturer. 

• Load labels face down in the bypass tray. 
• Load labels face up in trays 1–4. 
• Do not load labels in the high-capacity feeder. 

Envelopes are loaded incorrectly in trays 1–4. Load envelopes in trays 1–4 with the flaps closed, flap-side down, 
and the short edge leading into the printer. 

Envelopes are loaded incorrectly in the 
bypass tray. 

• Load envelopes in the bypass tray with the print side down, flaps 
closed, and the short edge leading into the printer. 

• Ensure that the width guides rest loosely against the edge of the 
envelopes without restricting their movement. 

 
 

Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and make sure that you have removed all 
of the jammed paper. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 
  

Note: Check for, and remove, torn pieces of paper in the paper path. 
 
 

Jams During Automatic 2-Sided Printing 
 

Probable Causes Solutions 

Using paper of the wrong size, thickness, or 
type. 

• Use only Xerox approved paper. For details, see Supported Paper 
Sizes and Weights for Automatic 2-Sided Printing on page 54. 

• For automatic 2-sided printing, do not use transparencies, 
envelopes, labels, reloaded paper, or paper heavier than 105 
g/m². 

Paper is loaded in the wrong tray. The paper must be loaded in the correct tray. For details, see 
Supported Paper on page 50. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 
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Print-Quality Problems 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/WC4265support. 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

 

Note: To ensure consistent print quality, the toner cartridges and imaging units for many models of 
equipment are designed to cease functioning at a predetermined point. 
 

Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer and set the paper type correctly. Follow the guidelines in this 
section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal 
print quality is 10–30°C (50–90°F) and 20–80% relative humidity. 
 

Solving Print-Quality Problems 

When the print quality is poor, select the closest symptom from the following table and see the 
corresponding solution to correct the problem. You can also print a Demo Page to more precisely 
determine the print-quality problem. 

If the print quality does not improve after carrying out the appropriate action, contact your Xerox 
representative. 

Note: To maintain print quality, the toner cartridge is designed to provide a warning message when 
the toner level is low. When the toner cartridge reaches this level, a warning message appears. Once 
the toner cartridge is empty, another message prompts you to replace the toner cartridge. The 
printer stops printing until you install a new toner cartridge. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=tech&Language=English
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Symptom Solutions 

The output is too light. 

 

• To check the toner level, check the control panel, use the print driver, or 
CentreWare Internet Services. If the toner cartridge is near empty, 
replace it. 

• Verify that the toner cartridge is approved for use in this printer, and 
replace it as needed. For best results, use a genuine Xerox toner cartridge. 

• Ensure that the print quality mode is not set to Toner Saver. Toner Saver 
us useful for draft quality output. 

• Replace the paper with a recommended size and type, and confirm that 
your printer and print driver settings are correct. 

• Verify that the paper is dry and that supported paper is used. If not, 
change the paper. 

• Change the Paper Type settings in the print driver. 
In the Printing Preferences of the print driver, on the Paper/Output tab, 
change the Paper Type setting. 

• If printer is located in a high altitude environment, adjust the altitude 
setting of the printer. For details, see the System Administrator Guide at 
www.xerox.com/office/WC4265docs. 

Toner smears or print comes off. 
The output has stains on the back 
side. 

 

• Change the Paper Type settings in the print driver. For example, change 
Plain to Lightweight Cardstock. 
In the Printing Preferences of the print driver, on the Paper/Output tab, 
change the Paper Type setting. 

• Verify that the paper is the correct size, type, and weight. If not, change 
the paper settings. 

• Verify that the printer is plugged into an outlet that is providing the 
correct voltage and power. Review the electrical specification of the 
printer with an electrician if necessary. 

• For details, see Electrical Specifications on page 185. 

Random spots on the output, or the 
image is blurry. 

 

• Ensure that the toner cartridge is installed correctly. 
• If you used a non-genuine brand toner cartridge, install a genuine Xerox 

toner cartridge. 
• Use the Heavyweight or Cardstock paper type setting, or use paper type 

with a smoother surface. 
• Ensure that the humidity in the room is within specifications. For details, 

see Relative Humidity on page 184. 
• For details, see Selecting a Location for the Printer on page 35. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
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Symptom Solutions 

The output is blank. 

 

• Turn off the printer, then turn it on again. 
• If the error persists, contact your Xerox representative. 

Streaks appear in the output. 

 

• Replace the Smart Kit Drum Cartridge. 
• Contact your Xerox representative. 

The output has a mottled 
appearance. 

 

• Verify that the paper is the correct size, type, and weight. If not, change 
the paper settings. 

• Ensure that the humidity is within specifications. For details, see Selecting 
a Location for the Printer on page 35. 

Ghosting appears in the printed 
output. 

 

• Verify that the paper is the correct size, type, and weight. If not, change 
the paper settings. 

• Change the Paper Type settings in the print driver. 
In the Printing Preferences of the print driver, on the Paper/Output tab, 
change the Paper Type setting. 

• Replace the Smart Kit Drum Cartridge. 
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Symptom Solutions 

Auger marks appear on the printed 
output. 

 

• To check the toner level, check the control panel, use the print driver, or 
CentreWare Internet Services. If the toner cartridge is near empty, 
replace it. 

• Verify that the toner cartridge is approved for use in this printer, and 
replace it as needed. For best results, use a genuine Xerox toner cartridge. 

• Replace the Smart Kit Drum Cartridge. 

The output print is wrinkled or 
stained. 

 

• Verify that the paper is the correct size, type, and weight for the printer 
and that it is loaded properly. If not, change the paper. 

• Try a new ream of paper. 
• Change the Paper Type settings in the print driver. 

In the Printing Preferences of the print driver, on the Paper/Output tab, 
change the Paper Type setting. 

Envelopes are wrinkled or creased 
when printed. 

• Ensure that envelopes are loaded properly in the bypass tray or in trays 
1–4. 

• Follow the guidelines for printing on envelopes. For details, see Guidelines 
for Printing Envelopes. on page 63 

The top margin is incorrect. 

 

• Ensure that the paper is loaded properly. 
• Ensure that the margins are set correctly in the application you are using. 

The printed surface of the paper is 
bumpy. 

 

1. Print a solid image over the entire surface of one sheet of paper. 
2. Load the printed sheet into the tray with the printed side face down. 
3. Print five blank pages to remove debris from the fuser rollers. 
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Copy and Scan Problems 

If the copy or scan quality is poor, refer to the following table. 
 

Symptoms Solutions 

Lines or streaks present in copies only made 
from the document feeder. 

There is debris on the document glass. When scanning, the paper 
from the document feeder passes over the debris creating lines or 
streaks. Clean all glass surfaces with a lint-free cloth. 

Spots present in copies taken from the 
document glass. 

There is debris on the document glass. When scanning, the debris 
creates a spot on the image. Clean all glass surfaces with a lint-free 
cloth. 

The reverse side of the original is showing on 
the copy or scan. 

Turn on Background Suppression. 

Image is too light or too dark. To lighten, darken, or adjust contrast, touch the More Features tab. 
 

If the problem persists, for online support information, go to www.xerox.com/office/WC4265support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=tech&Language=English
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Fax Problems 

Note: If you cannot send and receive faxes, ensure that you are connected to an approved analog 
or digital telephone line. 

To troubleshoot fax connection issues: 
 

Problems Sending Faxes 
 

Symptoms Causes Solutions 

The document is not scanned 
using the document feeder. 

The document is too thick, too thin, or 
too small. 

Use the document glass to send the 
fax. 

The document is scanned at an 
angle. 

The document feeder guides are not 
adjusted to the width of the document. 

Adjust the document feeder guides to 
fit the width of the document. 

The fax received by the recipient 
is blurry. 

The document is incorrectly positioned. Position the document correctly. 

The document glass is dirty. Clean the document glass. 

The text in the document is too light. Adjust the resolution. Adjust the 
contrast. 

There is a problem with the telephone 
connection. 

Verify that the telephone line is 
working, then send the fax again. 

There is a problem with the fax 
machine of the caller. 

Make a copy to verify that your printer 
is operating correctly. If the copy was 
printed correctly, have the recipient 
verify the condition of their fax 
machine. 

The fax received by the recipient 
is blank. 

The document was loaded incorrectly. • Document feeder: Place the original 
document face up. 

• Document glass: Place the original 
document face down. 

Fax was not transmitted. The fax number is wrong. Verify the fax number. 

The telephone line is incorrectly 
connected. 

Verify the telephone line connection. If 
it is disconnected, connect it. 

There is a problem with the fax 
machine of the recipient. 

Contact the recipient. 

The fax is not installed or is not 
enabled. 

Verify that the fax is installed and 
enabled. 

Server Fax is enabled. Make sure that Server Fax is disabled. 

If the problem persists, for online support information, go to www.xerox.com/office/WC4265support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=tech&Language=English
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Problems Receiving Faxes 
 

Symptoms Causes Solutions 

The received fax is blank. There is a problem with the telephone 
connection or with the fax machine of 
the caller. 

Verify that the printer can make clean 
copies. If it can, have the caller send 
the fax again. 

The sender loaded the pages 
incorrectly. 

Contact the sender. 

The printer answers the call, but 
does not accept incoming data. 

Not enough memory. If the job contains several graphics, the 
printer could not have enough memory. 
The printer does not answer when 
memory is low. Delete stored 
documents and jobs then wait for the 
existing job to complete. This increases 
available memory. 

The received fax size is reduced. The paper supply in the printer does 
not match the document size sent. 

Confirm the original size of the 
documents. Documents could be 
reduced based on the available paper 
supply in the printer. 

Faxes cannot be received 
automatically. 

The printer is set to receive faxes 
manually. 

Set the printer to automatic reception. 

The memory is full. Load paper if it is empty, and then 
print the faxes stored in the memory. 

The telephone line is incorrectly 
connected. 

Verify the telephone line connection. If 
it is disconnected, connect it. 

There is a problem with the fax 
machine of the sender. 

Make a copy to verify that your printer 
is operating correctly. If the copy prints 
correctly, have the recipient verify their 
fax machine is operating correctly. 

If the problem persists, for online support information, go to www.xerox.com/office/WC4265support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=tech&Language=English
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Getting Help 

This section includes: 
• Control Panel Messages .................................................................................................................................................. 173 
• Online Support Assistant ................................................................................................................................................ 174 
• Using the Integrated Troubleshooting Tools ......................................................................................................... 175 

Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality. 
 

Control Panel Messages 

The printer control panel provides information and troubleshooting help. When a fault or warning 
condition occurs, the control panel displays a message informing you of the problem. In many cases, the 
control panel also displays an animated graphic showing the location of the problem, such as the 
location of a paper jam. For many status and warning messages, the control panel Help provides 
additional information. 
 

Control Panel Help 

To view more information about error or status messages on the control panel, touch the Help button. 

 

The control panel menu items also have associated help text that describes the menu item. 
 

Viewing Warning Messages on the Control Panel 

When a warning condition occurs, a message appears on the control panel to inform you of the problem. 
Warning messages inform you about printer conditions, such as low supplies or open doors, that require 
your attention. If more than one warning condition occurs, only one appears on the control panel. 
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Viewing Fault and Alert Messages on the Control Panel 

When a fault condition occurs, a message appears on the control panel to inform you of the problem. 
Fault messages warn you about printer conditions that prevent the printer from printing or degrade 
printing performance. If more than one fault occurs, only one is displayed on the control panel. 

To view a list of the current faults on the control panel: 
1. Press Machine Status, then touch the Active Messages tab. 
2. Touch the Faults and Alerts menu, then choose an option. 

− Faults: This menu shows the fault messages that affect the operation of the printer and their 
corresponding fault codes. 

− Alerts: This menu shows alert messages regarding the current job status of the printer and the 
corresponding alert codes. 

 

Viewing Job Status on the Control Panel 

To view current or saved jobs on the control panel: 
1. At the control panel, press the Job Status button. 
2. To view a list of active jobs, touch Active Jobs. 
3. To view a list of personal and secure jobs, touch Personal & Secure Jobs. 
4. To view a list of completed jobs, touch Completed Jobs. 
 

Online Support Assistant 

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to 
solve your printer problems. You can find solutions for print-quality problems, paper jams, software 
installation issues, and more. 

To access the Online Support Assistant, go to www.xerox.com/office/WC4265support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=tech&Language=English
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Using the Integrated Troubleshooting Tools 

To troubleshoot print-quality problems and paper jams, you can use several integrated tools such as 
Information pages and CentreWare Internet Services. 
 

Available Information Pages 

Information pages provide important details to help you troubleshoot issues or analyze printer use. You 
can print information pages from the printer control panel. 
 

Information Page Description 

Configuration Report The Configuration Report provides product information including, installed 
options, network settings, port setup, tray information, and more. 

Customer Assistance Report The Customer Assistance Report provides a summary of relevant information 
that you can provide to a Xerox support representative when you call for 
assistance. 

Demo Page The Demo page provides a demonstration of the current print quality. 

Email Sent Report The Email Sent Report provides a record of emails sent, including From, To, Date 
& Time, Subject, and Result. 

Error Message Report The Error Message Report provides a record of errors, including fault and alert 
codes and date and time of the error. 

Fax Broadcast Report The Fax Broadcast Report provides a record of broadcast faxes, including total 
pages scanned, remote station, start time, and result. 

Fax Options Report The Fax Options Report displays the current fax settings. 

Fax Phone Book The Fax Phone Book displays a list of names and fax numbers. 

Fax Protocol Report The Fax Protocol Report provides fax control field data, fax information field 
data, and Send/Receive information. 

Fax Receive Report The Fax Receive Report provides a record of faxes received. 

Fax Transmission Report The Fax Transmission Report provides a record of faxes sent. 

Group Address Book The Group Address Book displays contents of the Group Address Book, including 
group number, group name, user name, and email address. 

Junk Fax Report The Junk Fax Report displays a record of junk faxes received and the numbers 
from which they were sent. 

Last 40 Error Messages Report The Last 40 Error Messages Report is a log of the last 40 error messages, with 
number, code, name, date, and time. 

Email address book The Email Address Book displays contents of the email address book. 

Pending Jobs Report The Pending Jobs Report provides a record of pending outbound and inbound 
jobs. 

User Authentication Report The User Authentication Report provides a list of authenticated users and login 
IDs. 

For information on how to print information pages, see Information Pages on page 27. 
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CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in CentreWare Internet Services or the System Administrator Guide. 

To access CentreWare Internet Services: 

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press 
Enter or Return. 

If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30. 
 

More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/WC4265docs 

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and driver downloads. 

www.xerox.com/office/WC4265support 

Information Pages • At the printer control panel, press Help. 
• In CentreWare Internet Services, click Properties > 

General Setup > Configuration > Print System 
Data List. 

CentreWare Internet Services documentation In CentreWare Internet Services, click Help. 

Order supplies for your printer www.xerox.com/office/WC4265supplies 

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs. 

www.xerox.com/office/businessresourcecenter 

Local sales and support center www.xerox.com/office/worldcontacts 

Printer registration www.xerox.com/office/register 

Xerox® Direct online store www.direct.xerox.com/ 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC4265&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=businessresourcecenter&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=reg&Language=English
http://www.direct.xerox.com/
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Printer Configurations and Options 

Standard Configurations 
 

Model Includes 

WorkCentre 4265/S Multifunction Printer Standard features 

WorkCentre 4265/X Multifunction Printer • Standard features 
• Fax 

WorkCentre 4265XF Multifunction Printer • Standard features 
• Fax 
• 500-sheet finisher 
• 2100-sheet high-capacity feeder 
• One extra 520-sheet feeder 

 
 

Standard Features 
 

Print speed Standard mode supports up to 55 ppm for Letter and 53 ppm for A4 

2-Sided print speed Standard mode supports up to 50 ppm for Letter and 48 ppm for A4. 

Print resolution • Standard print-quality mode: 600 x 600 dpi 
• Enhanced print-quality mode: 1200 x 1200 dpi 

Paper capacity • Bypass tray with 100-sheet capacity 
• Tray 1 with 520-sheet capacity 

Maximum print size Legal (216 x 356 mm, 8.5 x 14 in.) 

2-Sided Printing Standard 

Copy speed • 1-sided copy: 55 copies per minute 
• 2-sided copy: 50 copies per minute 

Copy resolution 600 x 600 dpi 

Maximum copy size Legal (216 x 356 mm, 8.5 x 14 in.) 

Document feeder Duplex Automatic Document Feeder 

Document feeder capacity 100 sheets 

Scan resolution • Optical: 600 x 600 dpi 
• Enhanced: Up to 4800 x 4800 dpi 

Maximum scan size • Document Glass: 216 x 356 mm, 8.5 x 14 in. 
• Duplex Automatic Document Feeder: 216 x 356 mm, 8.5 x 14 in. 



Specifications 

 

 Xerox® WorkCentre® 4265 Multifunction Printer 179 
 User Guide 
 

Email and Scan file formats • JPEG 
• TIFF 
• PDF 
• XPS 

Control panel 4.3 inch LCD touch screen and keypad navigation 

Connectivity 
• Universal Serial Bus (USB 2.0) 
• USB Flash drive 
• Ethernet 10/100/1000Base-T 

Remote access CentreWare Internet Services 
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Physical Specifications 

Clearance Requirements for Standard Configuration 
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Clearance Requirements for Standard Configuration with Optional Finisher 
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Clearance Requirements for Standard Configuration with Optional Feeders 
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Clearance Requirements for Standard Configuration with Optional Finisher 
and Feeders 

 
 

Weights and Dimensions 
 

Width 62.17 cm (24.5 in.) 

Depth 51.13 cm (20.1 in.) 

Height 62.40 cm (24.6 in.) 

Weight 
S configuration 

42.41 kg (93.63lb.) 

Weight 
X configuration 

42.53 kg (93.89 lb.) 

Weight 
XF configuration 

92.39 kg (203.9 lb.) 
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Environmental Specifications 

Temperature 
• Operating Temperature: 10–32°C (50–90°F) 
• Optimum Temperature: 16–30°C (61–86°F) 
• Storage Temperature: from –20 through 40°C (from –4 through 104°F) 
 

Relative Humidity 
• Minimum–Maximum Humidity Range: 10–90%, less than 90% when in the packaging 
• Optimum Humidity: 30–70% 
• Operating Humidity: 20–80% Relative Humidity 
 

Elevation 

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.). 
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Electrical Specifications 

Power Supply Voltage and Frequency 
  

Power Supply Voltage Power Supply Frequency 

110–127 VAC +/-10%, (99–140 VAC) 50 Hz 
60 Hz 

220–240 VAC +/-10%, (198–264 VAC) 50 Hz 
60 Hz 

 
 

Power Consumption 
• Energy Saver Mode (Sleep): Less than 1.5W 
• Continuous printing: Less than 900W 
• Ready/Standby: Less than 30W 

This printer does not consume electric power when the power switch is turned off even if the printer is 
connected to an AC outlet. 
 

ENERGY STAR Qualified Product 
 
 
 
 

 

This product is ENERGY STAR® qualified under the ENERGY STAR Program 
Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between United 
States, European Union, and Japanese governments and the office equipment industry 
to promote energy-efficient copiers, printers, fax, multifunction printers, personal 
computers, and monitors. Reducing product energy consumption helps combat smog, 
acid rain, and long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 

 

ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Energy Saver Modes 
after 5 minutes from the last copy or print. 
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Performance Specifications 

Printer warm up time: 
• Power on: 60 seconds 
• From power saver: 15 seconds 
 

Print Speed 

Maximum print speeds for 1-sided continuous printing are 55 ppm for Letter (8.5 x 11 in.) and 53 ppm 
for A4 (210 x 297 mm). 

Several factors affect print speed: 
• 2-sided printing: The maximum print speeds for 2-sided continuous printing are 50 ppm for Letter 

(8.5 x 11 in.) and 48 ppm for A4 (210 x 297 mm). 
• Print mode: Standard is the fastest print mode. Enhanced is half speed, or slower. 
• Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed. 
• Paper type: Plain paper prints faster than Cardstock or Heavyweight. 
• Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels. 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance 
with these instructions, it may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
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European Union 
 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with 
the following applicable Directives of the European Union as of the dates indicated: 
• December 12, 2006: Low Voltage Directive 2006/95/EC 
• December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC 
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 1999/5/EC 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

To ensure compliance with European Union regulations, use shielded interface cables. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
 

Introduction 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
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Environmental Benefits of Duplex Printing 

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to 
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the print 
driver. 
 

Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 
 

ENERGY STAR 

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy 
efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and 
models qualified to ENERGY STAR can be found at the following website: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ 
 

Power Consumption and Activation Time 

The amount of electricity a product consumes depends on the way the device is used. This product is 
designed and configured to enable you to reduce your electricity costs. After the last print, the device 
switches to Ready mode. In this mode, the device can print again immediately. If the product is not used 
for a period of time, the device switches to a Power Saver mode. In these modes, to enable reduced 
product power consumption, only essential functions remain active. 

The product takes slightly longer to produce the first print after it exits Power Saver mode than it takes in 
Ready mode. This delay is the result of the system waking up from Power Saver mode and is typical of 
most imaging products on the market. 

You can set a longer activation time or completely deactivate the Power Saver mode. This device can 
take longer to switch to a lower energy level. 

To learn more about Xerox participation in sustainability initiatives, go to: 
www.xerox.com/about-xerox/environment/enus.html. 
 

http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ
http://www.xerox.com/about-xerox/environment/enus.html
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Environmental Choice Certified to Office Machines CCD-035 
 
 
 

 

This product is certified to Environmental Choice standard for office machines, meeting 
all requirements for reduced environmental impact. As part of achieving certification, 
Xerox Corporation has proven this product meets the Environmental Choice criteria for 
energy efficiency. Certified copier, printer, multifunctional device, and fax products 
must also meet criteria such as reduced chemical emissions and demonstrate 
compatibility with recycled supplies. Environmental Choice was established in 1988 to 
help consumers find products and services with reduced environmental impacts. 
Environmental Choice is a voluntary, multi-attribute, and lifecycle-based environmental 
certification. This certification indicates that a product has undergone rigorous 
scientific testing, exhaustive auditing, or both, to prove its compliance with stringent, 
third-party, environmental performance standards. 

 
 

Germany 

Germany - Blue Angel 
 

 

RAL, the German Institute for Quality Assurance and Labeling, has awarded this device 
the Blue Angel Environmental Label. This label distinguishes it as a device that satisfies 
Blue Angel criteria for environmental acceptability in terms of device design, 
manufacture, and operation. For more information, go to: www.blauer-engel.de. 

 
 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 
 

Lärmemission 

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder 
weniger gemäß EN ISO 7779. 
 

Importeur 

Xerox GmbH 

Hellersbergstraße 2-4 

41460 Neuss 

Deutschland 
 

http://www.blauer-engel.de/
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Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
 

Regulatory Information for 2.4 GHz Wireless Network Adapter 

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the 
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 
99/5/EC. 

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the 
user's authority to operate this equipment. 
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Copy Regulations 

United States 

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
1. Obligations or Securities of the United States Government, such as: 

− Certificates of Indebtedness. 
− National Bank Currency. 
− Coupons from Bonds. 
− Federal Reserve Bank Notes. 
− Silver Certificates. 
− Gold Certificates. 
− United States Bonds. 
− Treasury Notes. 
− Federal Reserve Notes. 
− Fractional Notes. 
− Certificates of Deposit. 
− Paper Money. 
− Bonds and Obligations of certain agencies of the government, such as FHA and so on. 
− Bonds. United States Savings Bonds may be photographed only for publicity purposes in 

connection with the campaign for the sale of such bonds. 
− Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a 

canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes. 

− Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more 
than 150% of the linear dimensions of the original. 

− Postal Money Orders. 
− Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States. 
− Stamps and other representatives of value, of whatever denomination, which have been or 

may be issued under any Act of Congress. 
− Adjusted Compensation Certificates for Veterans of the World Wars. 

2. Obligations or Securities of any Foreign Government, Bank, or Corporation. 
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the 

reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. 
Further information of these provisions may be obtained from the Copyright Office, Library of 
Congress, Washington, D.C. 20559. Ask for Circular R21. 
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be 
photographed. 

5. Passports. Foreign Passports may be photographed. 
6. Immigration papers. 
7. Draft Registration Cards. 
8. Selective Service Induction papers that bear any of the following Registrant’s information: 

− Earnings or Income. 
− Court Record. 
− Physical or mental condition. 
− Dependency Status. 
− Previous military service. 
− Exception: United States military discharge certificates may be photographed. 

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the 
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the 
head of such department or bureau). 

Reproducing the following is also prohibited in certain states: 
• Automobile Licenses. 
• Drivers’ Licenses. 
• Automobile Certificates of Title. 

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case 
of doubt, consult your attorney. 

For more information about these provisions contact the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21. 
 

Canada 

Parliament, by stature, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
• Current bank notes or current paper money 
• Obligations or securities of a government or bank 
• Exchequer bill paper or revenue paper 
• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of 

a court of law 
• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause 

same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer 
for a province) 

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a 
province, the government of a state other than Canada or a department, board, Commission, or 
agency established by the Government of Canada or of a province or of a government of a state 
other than Canada 
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• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of 
a province or by the government of a state other than Canada 

• Documents, registers, or records kept by public officials charged with the duty of making or issuing 
certified copies thereof, where the copy falsely purports to be a certified copy thereof 

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or 
trademark owner 

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is 
assumed for its completeness or accuracy. In case of doubt, consult your solicitor. 
 

Other Countries 

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 
• Currency notes 
• Bank notes and checks 
• Bank and government bonds and securities 
• Passports and identification cards 
• Copyright material or trademarks without the consent of the owner 
• Postage stamps and other negotiable instruments 

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel. 
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Fax Regulations 

United States 

Fax Send Header Requirements 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or 
other electronic device, including a fax machine, to send any message unless such message clearly 
contains in a margin at the top or bottom of each transmitted page or on the first page of the 
transmission, the date and time it is sent and an identification of the business or other entity, or other 
individual sending the message and the telephone number of the sending machine or such business, 
other entity, or individual. The telephone number provided may not be a 900 number or any other 
number for which charges exceed local or long-distance transmission charges. 
 

Data Coupler Information 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, 
this number must be provided to the Telephone Company. 

A plug and jack used to connect this equipment to the premises wiring and telephone network must 
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant 
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack 
that is also compliant. See installation instructions for details. 

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the 
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation 
instructions for details. 

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be 
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing 
in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). 
To be certain of the number of devices that can be connected to a line, as determined by the RENs, 
contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the 
product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN 
without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately 
shown on the label. 
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To order the correct service from the local Telephone Company, you could also have to quote the codes 
in the following list: 
• Facility Interface Code (FIC) = 02LS2 
• Service Order Code (SOC) = 9.0Y 
 

 CAUTION: Ask your local Telephone Company for the modular jack type installed on your line. 
Connecting this machine to an unauthorized jack can damage telephone company equipment. You, 
not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this 
machine to an unauthorized jack. 

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could 
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not 
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the 
Telephone Company interrupts your service, they can advise you of your right to file a complaint with 
the FCC if you believe that it is necessary. 

The Telephone Company could change its facilities, equipment, operations, or procedures which could 
affect the operation of the equipment. If the Telephone Company changes something that affects the 
operation of the equipment, they should notify you in order for you to make necessary modifications to 
maintain uninterrupted service. 

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for 
repair or warranty information. Contact information is contained in the Machine Status menu on the 
printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing 
harm to the telephone network, the Telephone Company may request you to disconnect the equipment 
until the problem is resolved. 

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make 
repairs to the printer. This applies at any time during or after the service warranty period. If 
unauthorized repair is performed, the remainder of the warranty period is null and void. 

This equipment must not be used on party lines. Connection to party line service is subject to state 
tariffs. Contact the state public utility commission, public service commission, or corporation commission 
for information. 

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that 
the installation of this Xerox® equipment does not disable your alarm equipment. 

If you have questions about what could disable alarm equipment, consult your Telephone Company or a 
qualified installer. 
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Canada 

This product meets the applicable Industry Canada technical specifications. 

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or 
alterations made by the user to this device, or device malfunctions, could cause the telecommunications 
company to request you to disconnect the equipment. 

For user protection, make sure that the printer is properly grounded. The electrical ground connections of 
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected 
together. This precaution could be vital in rural areas. 
 

 WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric 
inspection authority, or electrician, to make the ground connection. 

The REN assigned to each terminal device provides an indication of the maximum number of terminals 
allowed to be connected to a telephone interface. The termination on an interface could consist of any 
combination of devices. The only limitation to the number of devices is the requirement that the sum of 
the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the 
equipment. 
 

European Union 

Radio Equipment and Telecommunications Terminal Equipment Directive 

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European 
single terminal connection to the public switched telephone network (PSTN). However, due to differences 
between the individual PSTNs provided in different countries, the approval does not give an 
unconditional assurance of successful operation on every PSTN network terminal point. 

In the event of a problem you should contact your authorized local dealer. 

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal 
equipment for use on analog-switched telephone networks in the European Economic Area. This product 
provides a user-adjustable setting of the country code. The country code should be set prior to 
connecting this product to the network. Refer to the customer documentation for the procedure for 
setting the country code. 
 

Note: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, we 
recommend that you set it to use DTMF signaling for more reliable and faster call setup. 
Modification of this product, connection to external control software, or connection to an external 
control apparatus not authorized by Xerox® will invalidate its certification. 

 
 

South Africa 

This modem must be used in conjunction with an approved surge protection device. 
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New Zealand 
1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 

accepted that the item complies with minimum conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not 
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it 
provides no assurance that any item will work correctly in all respects with another item of 
Telepermitted equipment of a different make or model. 
The equipment may not be capable of correct operation at the higher data speeds designated. 
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to 
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such 
circumstances. 

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its 
disposal or repair. 

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom 
customers. 

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is 
no guarantee that Telecom lines will always continue to support pulse dialing. 

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may 
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, 
do not contact the Telecom Faults Service. 

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is 
readily available on almost all New Zealand telephone exchanges. 

 

 WARNING: No '111' or other calls can be made from this device during a mains power failure. 

7. This equipment may not provide for the effective hand-over of a call to another device connected 
to the same line. 

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on 
the equipment (computer) associated with this device. The associated equipment shall be set to 
operate within the following limits for compliance with Telecom Specifications: 
For repeat calls to the same number: 
− There shall be no more than 10 call attempts to the same number within any 30 minute period 

for any single manual call initiation, and 
− The equipment shall go on-hook for a period of not less than 30 seconds between the end of 

one attempt and the beginning of the next attempt. 
For automatic calls to different numbers: 
The equipment shall be set to ensure that automatic calls to different numbers are spaced such that 
there is no less than five seconds between the end of one call attempt and the beginning of 
another. 

9. For correct operation, total of the RNs of all devices connected to a single line at any time should 
not exceed five. 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds 
• European Union: www.xerox.com/environment_europe 

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=msdsna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=environmenteu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=customersupport&Language=English
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All Countries 

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information 
about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal 
information, contact your local authorities. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC4265&PgName=environmentna&Language=English
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents 
mean that used electrical and electronic products and batteries should 
not be mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 
2002/96/EC and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items. 

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol Note 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a manufacturer-approved service facility. 
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 
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